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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal 
injury or death, property damage, or economic loss. 

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. 
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence. 

IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures. 

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will 
cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for 
Personal Protective Equipment (PPE). 
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Chapter 1 

What you need to get started 

The FactoryTalk® System Configuration Guide describes the tasks that are 
required to install, configure, and use FactoryTalk Alarms and Events services 
as part of a FactoryTalk-enabled automation system. This guide also includes 
references to additional documentation that provides more detail. 

IMPORTANT This guide describes how to set up a local station application. However, the procedure for 
setting up a network station application or network distributed application is similar. This 
guide provides information about the latter two applications where it is necessary. See 
the Help included with the individual software products used to configure and use Alarms 
and Events services. 

The following software is required to configure and operate FactoryTalk 
Alarms and Events services: 

Software Version 

FactoryTalk Services Platform 2.10 or later 
FactoryTalk Alarms and Events 2.10 or later (included with FactoryTalk View Site Edition and FactoryTalk® Linx™) 
FactoryTalk Linx 5.00 or later 
RSLogix 5000 16.03 or later (or the Logix Designer application version 21.00 or later) 
Logix Designer 21.00 or later (or RSLogix 5000® software version 16.03 or later) 
RSLogix 500 Version that supports FactoryTalk Services Platform 2.10 or later 
RSLogix 5 Version that supports FactoryTalk Services Platform 2.10 or later 
FactoryTalk View SE 5.00 or later 
FactoryTalk View Studio 5.00 or later 
RSLinx Classic (used for Logix programming) 2.50.20 or later 
ControlFLASH™ 4.00.09 (used to download firmware) 
SoftLogix™ 16.03 or later 
Microsoft® SQL Server® Version that supports FactoryTalk Alarms and Events historical logging. For more information, see Supported SQL 

Server databases on page 169. 

The hardware and supported operating systems that are recommended to run 
FactoryTalk Alarms and Events are the same as those recommended to run 
FactoryTalk View Site Edition. For details, see the FactoryTalk View Site Edition 
Installation Guide. To access the guide, in the FactoryTalk View Studio toolbar 
click Help, point to Online Books, and then click Installation Guide. 

The Logix 5000 controllers listed in the following table support FactoryTalk 
Alarms and Events services. When you use built-in alarm instructions in 
Logix 5000 controllers, these controllers require a firmware update to revision 
16.20 or later (excluding 21 to 23). If you do not want to update the firmware in 
your controllers, use a Tag Alarm and Event Server for software-based alarms 
and events. See Decide what type of alarm monitoring you need on page 26. 

Required software 

Recommended hardware 
and supported operating 
systems 

Logix 5000 controllers 
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Catalog number Name 
1756-L61 ControlLogix Processor 
1756-L62 ControlLogix Processor 
1756-L63 ControlLogix Processor 
1756-L64 ControlLogix Processor 
1756-5555 5555 ControlLogix Processor 
1768-L43 CompactLogix L43 Controller 
1769-L31 CompactLogix L31 Controller 
1769-L32C CompactLogix L32C Controller 
1769-L32E CompactLogix L32E Controller 
1769-L35CR CompactLogix L35CR Controller 
1769-L35E CompactLogix L35E Controller 
1794-L34 FlexLogix L34 Controller 
1756-L61S ControlLogix Safety Processor 
1756-L62S ControlLogix Safety Processor 
PowerFlex 700S 2 DriveLogix5370 
1789-L60 SoftLogix5800 
EMULATE RSLogix Emulate 5000 

The following controllers with firmware revision 24 and later support 
FactoryTalk Alarms and Events services: 

Catalog number Name 
ControlLogix 1756-L71 Series B ControlLogix Processor 
ControlLogix 1756-L71S Series B ControlLogix Safety Processor 
ControlLogix 1756-L72 Series A ControlLogix Processor 
ControlLogix 1756-L72 Series B ControlLogix Processor 
GuardLogix 1756-L72S Series B ControlLogix Safety Processor 
ControlLogix 1756-L73 Series A ControlLogix Processor 
ControlLogix 1756-L73 Series B ControlLogix Processor 
ControlLogix 1756-L73XT Series B ControlLogix Processor 
GuardLogix 1756-L73S Series B ControlLogix Safety Processor 
GuardLogix 1756-L73SXT Series B ControlLogix Safety Processor 
ControlLogix 1756-L74 Series A ControlLogix Processor 
ControlLogix 1756-L74 Series B ControlLogix Processor 
ControlLogix 1756-L75 Series A ControlLogix Processor 
ControlLogix 1756-L75 Series B ControlLogix Processor 
CompactLogix 1769-L16ER-BB1B CompactLogix L16ER-BB1B Controller 
CompactLogix 1769-L18ER-BB1B CompactLogix L18ER-BB1B Controller 
CompactLogix 1769-L18ERM-BB1B CompactLogix L18ERM-BB1B Controller 
CompactLogix 1769-L24ER-QB1B CompactLogix L24ER-QB1B Controller 
CompactLogix 1769-L24ER-QBFC1B CompactLogix L24ER-QBFC1B Controller 
CompactLogix 1769-L27ERM-QBFC1B CompactLogix L27ERM-QBFC1B Controller 
CompactLogix 1769-L30ER CompactLogix L30ER Controller 
CompactLogix 1769-L30ER-NSE CompactLogix L30ER-NSE Controller 
CompactLogix 1769-L30ERM CompactLogix L30ERM Controller 
CompactLogix 1769-L33ER CompactLogix L33ER Controller 
CompactLogix 1769-L33ERM CompactLogix L33ERM Controller 
CompactLogix 1769-L36ERM CompactLogix L36ERM Controller 
SoftLogix 1789-L60 SoftLogix5800 

Tip: Firmware revisions 21 to 23 do not support the new alarms functionality. 
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The following controllers with firmware revision 29 introduce support for 
FactoryTalk Alarms and Events services: 

Catalog number Name 
ControlLogix 1756-L81E ControlLogix Processor 
ControlLogix 1756-L82E ControlLogix Processor 
ControlLogix 1756-L83E ControlLogix Processor 
ControlLogix 1756-L84E ControlLogix Processor 
ControlLogix 1756-L85E ControlLogix Processor 
CompactLogix 5069-L306ER CompactLogix L306ER Controller 
CompactLogix 5069-L306ERM CompactLogix L306ERM Controller 
CompactLogix 5069-L310ER CompactLogix L310ER Controller 
CompactLogix 5069-L310ERM CompactLogix L310ERM Controller 
CompactLogix 5069-L310ER-NSE CompactLogix L306ER-NSE Controller 
CompactLogix 5069-L320ER CompactLogix L320ER Controller 
CompactLogix 5069-L320ERM CompactLogix L320ERM Controller 
CompactLogix 5069-L330ER CompactLogix L330ER Controller 
CompactLogix 5069-L330ERM CompactLogix L330ERM Controller 
CompactLogix 5069-L340ER CompactLogix L340ER Controller 
CompactLogix 5069-L340ERM CompactLogix L340ERM Controller 

The following controllers with firmware revision 30 introduce support for 
FactoryTalk Alarms and Events services: 

Catalog number Name 

CompactLogix 5069-L380ERM CompactLogix L380ERM Controller 
CompactLogix 5069-L3100ERM CompactLogix L3100ERM Controller 
CompactLogix 1769-L37ERMO CompactLogix L37ERMO Controller 
GuardLogix 1769-L37ERMOS CompactLogix Safety Processor 

The following controllers with firmware revision 32 introduce support for 
FactoryTalk Alarms and Events services: 

Catalog number Name 

CompactLogix 5069-L46ERMW CompactLogix 5480 Controller 
Automatic Diagnostics is supported only on Compact GuardLogix 5380, CompactLogix 5380, CompactLogix 5480, 
ControlLogix 5580, and GuardLogix 5580 controllers, and the firmware revision must be 33 or later. 

The controller firmware revisions listed in the following table are compatible 
with FactoryTalk Alarms and Events services: 

Controller Firmware revision 

ControlLogix 
16.20 or higher (excluding 21 to 23) CompactLogix L3x and L4x 

DriveLogix 
ControlLogix Redundant Systems 16.60 or higher (excluding 21 to 23) 
SoftLogix 16.03 or higher (excluding 21 to 23) 

These controllers also support FactoryTalk Alarms and Events services: 

• Logix 5000 controllers that communicate with FactoryTalk Linx, using
Tag Alarm and Event Servers.

Compatible firmware 

Older controllers 
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• PLC-5® and SLC™ 500 controllers that communicate with FactoryTalk
Linx (or RSLinx Classic to bridge from Ethernet to DH+™ or DH-485
networks), using Tag Alarm and Event Servers.

• Third-party PLCs that communicate with OPC® Data Servers such as
KEPWare, using Tag Alarm and Event Servers.

For more information about the products and components discussed in this 
guide, the following manuals and Help files are available: 

• FactoryTalk Help
• Studio 5000 Logix Designer Help (for help with developing a controller

project)
• Studio 5000 Logix Designer Online Books
• FactoryTalk View Site Edition Installation Guide
• FactoryTalk View Site Edition User Guide
• RSLinx Classic Help (for help with configuring drivers and creating

topics)
• RSLinx Classic Quick Start Guide
• FactoryTalk Linx Getting Results Guide
• FactoryTalk Linx Help

How to get the information 
you need 
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Chapter 2 

Overview of FactoryTalk Alarms and Events 
services 

FactoryTalk Alarms and Events was introduced with FactoryTalk Services 
Platform 2.0 (CPR 9) and FactoryTalk View Site Edition 5.0 (CPR 9) to provide 
a common, consistent view of alarms and events throughout a FactoryTalk 
system. 

Beginning with FactoryTalk Alarms and Events 2.30 (CPR 9 SR 3), device-
based and tag-based servers support redundant server configuration. 

IMPORTANT FactoryTalk View version 10.00 is the last release to support the legacy HMI tag alarms. 
We highly recommend that you update your alarming strategy to use FactoryTalk Alarms 
and Events. 

FactoryTalk Alarms and Events supports two types of alarm monitoring: 

• Device-based alarms, including:

• Logix instruction-based alarms

Alarm instructions are programmed and then downloaded into
Logix 5000 controllers. The controller detects alarm conditions and
publishes the alarm information, which is routed to FactoryTalk
Alarms and Events.

• Logix tag-based alarms

Logix tag-based alarms associate alarm conditions with tags for
Logix 5000 controllers. Logix tag-based alarms monitor tag values
to determine the alarm condition, but they are not part of the logic
program and do not increase the scan time for a project. Logix tag-
based alarms are supported only on Compact GuardLogix 5380,
CompactLogix 5380, CompactLogix 5480, ControlLogix 5580, and
GuardLogix 5580 controllers.

• Server tag-based alarms

If you are not using Logix 5000 controllers, or if you do not want to use
the built-in alarms or alarm instructions that are available with the
Logix Designer application, server tag-based alarm monitoring offers
the equivalent of HMI tag alarm monitoring, but with an expanded
feature set. Tag Alarm and Event servers monitor controllers for alarm
conditions through data servers and publish event information that
can be displayed and logged. Server tag-based alarm monitoring is
supported for Logix 5000 controllers, PLC-5, and SLC 500 devices
communicating through Rockwell Automation device servers
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(FactoryTalk Linx), or for third-party controllers communicating 
through OPC Data Servers. 

FactoryTalk Alarms and Events: 

• Provides a single, integrated set of alarm information.

All participating FactoryTalk products work together to provide a
consistent way to define, manage, log, and view alarm and event
information across a FactoryTalk application.

• Streamlines alarm programming and eliminates polling with device-
based alarm monitoring.

If your automation system includes Logix 5000 controllers, you can use
pre-built alarms or alarm instructions, available in the Logix Designer
application (RSLogix 5000 software version 16 or later), to simplify
coding, and then download them to the controller. Device-based alarm
monitoring eliminates the need for duplicating alarm tags in an HMI
server and requires fewer controller communication resources by
eliminating polling.

• Supports other controllers in the integrated system with server tag-
based alarm monitoring.

If your automation system includes other Rockwell Automation
controllers, such as PLC-5s or SLC 500s, or if you prefer not to use the
alarms or alarm instructions with Logix 5000 controllers, software-
based tag servers monitor controllers for alarm conditions and publish
event information.

• Monitors alarms and events from third-party controllers.

Server tag-based alarm monitoring also makes it possible to monitor
alarm conditions from third-party controllers, which communicate
through OPC Data Servers.

• Provides accurate time stamps on alarm conditions that are generated
from Logix 5000 controllers using device-based alarm monitoring.

When you use device-based alarm monitoring, timestamps are applied
immediately in the controller and are not delayed until alarms reach an
HMI server. To make sure that the timestamps on device-based alarms
are accurate, synchronize the clocks of all controllers that produce
alarms. The event time is propagated throughout the FactoryTalk
Alarms and Events system, so inaccurate timestamps can affect where
alarms are displayed in the Alarm and Event Summary or the Alarm
and Event Banner as well as reports about the alarm and event history.
For more information about synchronizing controller clocks, see Time
synchronization on page 179.)

• Subscribes to and displays diagnostic events enabled by the Automatic
Diagnostics feature of Studio 5000 Logix Designer. Automatic
Diagnostics is supported only on Compact GuardLogix 5380,
CompactLogix 5380, CompactLogix 5480, ControlLogix 5580, and
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GuardLogix 5580 controllers, and the firmware revision must be 33 or 
later. 

• Sends process data with events and messages.

You can associate up to four tags with each alarm to include process
data with event information and alarm messages.

• Secures access to alarm and event operations through integration with
FactoryTalk Security.

• Generates messages for logging.

Log messages include audit messages that track operator actions,
system-related diagnostic messages, and historical alarm and event
messages.

• Shows alarm messages and status information at runtime, in
FactoryTalk View graphic displays.

HMI tag alarm monitoring and FactoryTalk Alarms and Events are two 
separate alarm monitoring systems that do not share alarm information with 
each other. FactoryTalk tag-based and device-based alarm information can 
only be displayed in the FactoryTalk alarm and event objects. FactoryTalk 
View HMI tag alarm information cannot be displayed in FactoryTalk alarm 
and event objects. 

If you are already using HMI tag alarm monitoring in existing applications 
you can continue using it. However, to take advantage of the new features of 
FactoryTalk Alarms and Events you will need to migrate your existing alarm 
monitoring system to FactoryTalk Alarms and Events. 

Migrate to FactoryTalk Alarms and Events if you want to: 

• Use device-based alarm monitoring. You can use a Logix 5000
controller not only to detect alarms, but also to monitor alarms. This
keeps all alarm and event processing in the controller. To use device-
based alarm monitoring, add the built-in alarm instructions, available
in the Logix Designer application (or RSLogix 5000 software version 16
or later), to a logic project and then download the project to a Logix
5000 controller. The controller detects alarm conditions and publishes
event information, which can be displayed and logged.

• Use language-switching with alarm messages. Language switching is
not supported for alarm messages when you use HMI tag alarm
monitoring in FactoryTalk View Site Edition. FactoryTalk View
Machine Edition supports language-switching with alarm messages in
version 5.0 or later.

• Take advantage of the richer feature set offered by FactoryTalk Alarms
and Events, including:

• Redundant software-based Tag Alarm and Event servers that
monitor controllers for alarm conditions through data servers and
publish event information that can be displayed and logged.

Choose between HMI Tag 
Alarm Monitoring and 
FactoryTalk Alarms and 
Events 
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• Configurable Alarm and Event Summary that includes the ability to
suppress alarms directly from the summary, without the use of
separate commands.

• Alarm and Event Banner, Alarm and Event Log Viewer, and Alarm
Status Explorer objects that are hosted in graphic displays. You can
use the Alarm Status Explorer to enable or disable alarms, suppress
or unsuppress alarms, shelve or unshelve alarms, and view operator
comments.

• System-wide views in the Alarm and Event Banner, rather than just
the alarms in a single HMI server exposed by the
system\AlarmBanner system tag.

Here is an overview of the sections covered in this guide: 

1. Overview of FactoryTalk Alarms and Events services on page 13
2. Plan your system on page 25

• Set up device-based alarm monitoring

a. Define device-based alarms in Logix 5000 controllers on page 29
b. Add a device server for Logix 5000, PLC-5, or SLC 500 controllers
on page 39

• Set up tag-based alarm monitoring

a. Add an OPC data server for third-party controllers on page 47
b. Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or
third-party controllers on page 51

3. Set up graphic displays on page 59
4. Monitor and interact with alarms at runtime on page 83
5. Set up historical alarm and event logging on page 101
6. Configure redundancy for alarms and events on page 119

Where to start 

FactoryTalk Alarms and 
Events components 
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The following diagram shows a high-level view of the components of the 
FactoryTalk Alarms and Events system. For more detailed information, see 
FactoryTalk Alarms and Events Help. 

Device-based alarm monitoring 
With device-based alarm monitoring that are available with the Studio 5000 
Logix Designer application, pre-built alarms or alarm instructions are 
configured and then downloaded into a Logix 5000 controller. The controller 
detects alarm conditions and notifies alarms and events services of alarm 
states. Software components publish this information to a device server. From 
the device server, the information can be logged to a database and monitored 
from FactoryTalk View graphic displays. 

Use device-based alarm monitoring with Logix 5000 controllers, programmed 
with the Logix Designer application, communicating through Rockwell 
Automation Device Servers (FactoryTalk Linx). 
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Server tag-based alarm monitoring 
If you are not using Logix 5000 controllers, or if you do not want to use the 
pre-built alarming available with the Logix Designer application, server tag-
based alarm monitoring offers the equivalent of HMI tag alarm monitoring, 
but with an expanded feature set. The server tag-based Alarm and Event 
servers monitor controllers for alarm conditions through data servers and 
publish event information for display and logging. These data servers serve 
tags, or data items, contained in OPC-DA (Data Access) servers. Clients that 
need access to data items, such as FactoryTalk View Studio and FactoryTalk 
Transaction Manager, use data server application elements referenced from 
the FactoryTalk Directory to locate the computers that are hosting OPC-DA 
2.0 compliant data servers. 

Use the server tag-based alarm monitoring for Logix 5000 controllers, PLC-5 
devices, and SLC 500 devices communicating through Rockwell Automation 
Device Servers (FactoryTalk Linx), or for third-party controllers 
communicating through OPC data servers. 

FactoryTalk Alarms and Events services 
Both device-based and tag-based alarms and events are published to 
FactoryTalk Alarms and Events services, which then routes the information to 
FactoryTalk Alarms and Events objects hosted in FactoryTalk View, the alarm 
and event history log, and to diagnostic logs and audit logs. 

Alarm and Event Historian 
The Alarm and Event Historian is a logging component that installs silently as 
part of the FactoryTalk Alarms and Events software. It manages connections 
between alarm servers and databases and logs data from each alarm server to 
an alarm history database. An Alarm and Event Log Viewer allows viewing and 
printing data from alarm history databases. Third-party database tools can 
also retrieve, view, analyze, and print alarm history information. 

To use alarm and event logging, install SQL Server separately, or use an 
existing SQL Server database. See the release notes for FactoryTalk Alarms 
and Events for the latest qualified versions of SQL Server. 

Diagnostic and audit logs 
FactoryTalk Diagnostics routes messages generated by FactoryTalk Alarms 
and Events to Local logs on the computers hosting FactoryTalk components, 
and optionally to a centralized database log. Audit messages are routed to the 
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Local log as well and to the FactoryTalk Audit Log if FactoryTalk AssetCentre is 
installed. 

Alarm and event setup and monitoring 
These components define alarm conditions, set up alarm servers, view and 
interact with alarm conditions, and view and run reports on historical alarm 
information: 

• Alarm and Event Banner

Use the Alarm and Event Banner object, embedded in a FactoryTalk
View graphic display, to monitor and respond to the most serious
alarms requiring immediate attention.

• Alarm and Event Log Viewer

Use the Alarm and Event Log Viewer object, embedded in a
FactoryTalk View graphic display, to view, filter, and print historical
alarm information stored in SQL Server databases.

• Alarm and Event Summary

Use the Alarm and Event Summary object, embedded in a FactoryTalk
View graphic display, to acknowledge, disable, suppress, filter, and sort
alarms during runtime.

• Alarm Status Explorer

Use the Alarm Status Explorer object, embedded in a FactoryTalk View
graphic display, to enable or disable alarms, suppress or unsuppress
alarms, shelve or unshelve alarms, and view operator comments.

• Automatic Diagnostic Event Summary

Use the Automatic Diagnostic Event Summary object, embedded in a
FactoryTalk View graphic display, to suppress, unsuppress, filter, and
sort diagnostic events during runtime.

• Alarm Server Setup

Use either FactoryTalk View Studio or FactoryTalk Administration
Console to add Rockwell Automation Device Servers (as part of
configuring FactoryTalk Linx data servers) and Tag Alarm and Event
Servers to a FactoryTalk application.

• Database definitions

Use database definitions to define logging options from an alarm
server to a SQL Server database.

• Diagnostics Viewer

Use the Diagnostics Viewer to view, filter, and export system-
generated diagnostic messages. Run the Diagnostics Viewer from
either FactoryTalk View Studio or FactoryTalk Administration Console.

• FactoryTalk Audit Log
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Use the FactoryTalk Audit Log to view and manage audit messages 
routed by FactoryTalk Diagnostics. To access the Audit Log, use 
FactoryTalk AssetCentre software. 

You can monitor for alarm conditions in either of two ways--using device-
based alarm monitoring, or server tag-based alarm monitoring. 

With device-based alarm monitoring, detection and monitoring for alarm 
conditions are both done in the controller. This is in contrast to server tag-
based alarm monitoring, where alarm detection occurs in the controller, but 
alarm monitoring is performed by software-based servers. 

 Alarm instructions or alarms are programmed and then downloaded 
into a Logix 5000 controller. 

 The controller detects alarm conditions and notifies its device server, 
FactoryTalk Linx, of alarm states. 

 The device server extracts alarms and publishes the information to 
FactoryTalk Alarms and Events services. 

 FactoryTalk Alarms and Events services routes the alarm information to 
logs and to Alarm and Event objects embedded in graphic displays in 
FactoryTalk View. 

 Operators interact with alarms through objects embedded in graphic 
displays, such as Alarm and Event Summary, Alarm and Event Banner, and 
Alarm Status Explorer. 

This approach offers a number of benefits over generic methods of alarm 
detection: 

About monitoring for alarm 
conditions 
About device-based alarm 
monitoring 

Device-based alarm 
monitoring workflow 
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• Alarm instructions are programmed only once, and then downloaded
to the controller, reducing programming effort and errors.

• Alarm conditions are detected more quickly.
• Real-time alarming is performed in the controller.
• HMI tags or alarms in a Tag Alarm and Event Server are not required,

reducing overhead and potential tag-mapping errors.
• Alarm states are managed, processed, and preserved by controllers,

even if a server goes down.
• Data polling is eliminated; alarm status is communicated only when

state changes, reducing network overhead and controller processing,
and improving overall system performance.

• Time stamps on alarm conditions are more accurate, because they are
applied in the controller, and not delayed until they reach the HMI
software or Tag Alarm and Event Server. Because device-based alarms
are stamped with the controller’s time, all controllers producing
alarms must have their clocks synchronized. The event time is
propagated throughout the FactoryTalk Alarms and Events system, so
inaccurate time stamps can affect where alarms are displayed in the
Alarm and Event Summary or the Alarm and Event Banner as well as
reports based on the alarm and event history. For more information
about synchronizing controller clocks, see Time synchronization on
page 179.

HMI tag alarm monitoring, offered by FactoryTalk View Site Edition (SE), 
and tag-based alarm monitoring, offered by FactoryTalk Alarms and Events, 
are both examples of software-based alarm monitoring.   

Software-based alarm monitoring is a generic way of monitoring alarms from 
legacy or third-party controllers. 

With software-based alarm monitoring, alarm detection occurs in the 
controller, but alarm monitoring is performed by software-based servers. 

About server tag-based 
alarm monitoring 

Server tag-based alarm 
monitoring workflow 
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 Logic in a controller is programmed to detect problems and latch alarm 
conditions in tags. 

 Alarm conditions are defined through software hosted by FactoryTalk 
View Studio or FactoryTalk Administration Console. 

A Tag Alarm and Event Server polls controller tags and notifies clients, 
including FactoryTalk Alarms and Events, of alarm conditions. 

 FactoryTalk Alarms and Events services routes the alarm information to 
logs and to Alarm and Event objects embedded in graphic displays in 
FactoryTalk View. 

 Using FactoryTalk View SE Clients, operators interact with alarms 
(acknowledge, disable, suppress, and other commands) from graphic displays, 
such as the Alarm and Event Summary, the Alarm and Event Banner, and the 
Alarm Status Explorer. 

This approach has several disadvantages: 

• Programming is required in both the controller, and the HMI software
or Tag Alarm and Event Server.

• Tags must be duplicated in the HMI server and mapped to the
controller. For Tag Alarm and Event Servers, controller tags must be
mapped to alarms--which can be a tedious, error-prone process.

• Alarms are detected and processed twice, first in the controller logic
and then again in the HMI software or Tag Alarm and Event Server.

• Polling between the HMI server or Tag Alarm and Event Server and
controller tags increases network overhead.

• Alarm time stamps are delayed because they are applied by the HMI
server or Tag Alarm and Event Server after polling and processing,
rather than immediately when they occur. Time stamps are not
synchronized among multiple alarm servers.

• Alarm acknowledge and enable states are held in the computer, and
not in the controller. If the computer fails, alarm state information is
lost.

Use device-based alarm monitoring with: 

• Logix 5000 controllers, using downloaded alarms or alarm instructions
programmed with the Logix Designer application (or RSLogix 5000
software version 16 or later)

Use server tag-based alarm monitoring with: 

• Logix 5000 controllers
• PLC-5, SLC 500 devices
• Third-party controllers that communicate through OPC Data Servers

Choose between device-
based and server tag-based 
alarm monitoring 
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FactoryTalk Alarms and Events graphic objects are on the Objects menu in the 
graphics editor in FactoryTalk View Site Edition. The HMI tag alarm 
monitoring objects remain available for compatibility with existing 
applications. 

To do this 
In HMI tag alarm monitoring, you do it this 
way 

With FactoryTalk Alarms and Events, you 
do it this way 

Acknowledge, disable, suppress, 
filter, and sort alarms at runtime 

HMI Tag Alarm Summary Alarm and Event Summary 

Enable or disable alarms, 
suppress or unsuppress alarms, 
and view operator comments 

HMI Tag Alarm Summary (suppress only, using 
the Execute feature) 
SuppressOn and SuppressOff commands 
Suppressed list 

Alarm and Event Summary (suppress only; to 
unsuppress alarms, use the Alarm Status 
Explorer) 

Alarm Status Explorer 

Monitor and respond to the most 
serious alarms that require 
immediate attention 

Alarm system tags Alarm and Event Banner 

View, filter, and print historical 
alarm information 

HMI Tag Alarm Log Viewer 
Alarms are logged to a proprietary format, and 
can be exported to an ODBC-compliant 
database. 

Alarm and Event Log Viewer 
Historical alarm information is stored in 
Microsoft SQL Server databases. 

Graphic objects in 
FactoryTalk Alarms and 
Events 
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Chapter 3 

Plan your system 

Before you build and deploy FactoryTalk Alarms and Events as part of a local 
or network application, consider which computer hardware and operating 
systems you plan to use, and where to install the various hardware and 
software components. The information in this chapter offers some guidelines 
as you begin planning. See also Required software on page 9 and 
Recommended hardware and supported operating systems on page 9. 

You must decide whether you are building a local station application or 
network station application on a stand-alone computer, or a network 
distributed application distributed across multiple computers. This system 
configuration guide primarily discusses how to install, configure, and use 
software on a stand-alone system. 

IMPORTANT FactoryTalk Alarms and Events is not supported for use with FactoryTalk View Machine 
Edition. 

• Network distributed applications are held in a FactoryTalk Network
Directory. Participating software products can be located on multiple
computers, distributed across a network. All of the computers
participating in a particular network distributed application share a
common Network Directory Server located on a network computer.
See Typical distributed system on a network on page 189 for a
graphical overview.

The application you create in the Network Directory can be divided
into any number of areas. Each area can contain one or more sub-areas
and one or more data servers. Each area or sub-area can contain only
one HMI server. A network distributed application supports
FactoryTalk Alarms and Events redundancy.

• Network station applications are held in a FactoryTalk Network
Directory. All participating software products (except for data servers)
must be installed on the same computer. Network station applications
can connect to data servers that are located on different machines. All
of the computers participating in a particular network station
application share a common Network Directory Server located on a
network computer. See Typical stand-alone system on page 27 for a
graphical overview.

The application you create in the Network Directory can be divided
into any number of areas. Each area can contain one or more sub-areas
and one or more data servers. A network station application consists of
only one HMI server. You can add the HMI server in the root area or

Decide what type of 
application you are building 
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within the areas you have created. A network station application 
supports FactoryTalk Alarms and Events redundancy.  

• Local station applications are suitable for self-contained, stand-alone
processes that do not interact with other processes or systems. Local
station applications are held in a FactoryTalk Local Directory and are
accessible only from the local computer where they reside. Even if the
computer is connected to a network and even if a network application
resides on the same computer, the applications you create in the
FactoryTalk Local Directory remain self-contained and do not share
data or project elements.

Local station applications do not support areas, and all application
components and participating software products are located on a
single computer. See Typical stand-alone system on page 27 for a
graphical overview.

IMPORTANT To use FactoryTalk Alarms and Events with a local station application, install all 
software on the same computer. 
FactoryTalk Alarms and Events redundancy is only supported in network station 
applications and network distributed applications. 

FactoryTalk Alarms and Events supports two types of alarm monitoring: 

• Device-based alarm monitoring

Built-in alarms or alarm instructions, that are available in the Logix
Designer application (RSLogix 5000 software version 16 or later), are
programmed in a logic project and then downloaded to a Logix 5000
controller. The controller detects alarm conditions and publishes event
information, which can be displayed and logged.

• Server tag-based alarm monitoring

Software-based tag alarm and event servers monitor controllers for
alarm conditions through data servers and publish event information,
which can be displayed and logged. Tag-based alarm monitoring is
supported for Logix 5000, PLC-5, and SLC 500 devices communicating
through Rockwell Automation device servers (FactoryTalk Linx), or for
third-party controllers that communicate through OPC Data Servers.

You can use a mix of both types of alarm monitoring. Choose server tag-based 
alarm monitoring if you do not want to change the logic in your 
programmable controllers, or if you do not want to update the firmware in 
Logix 5000 controllers. 

Follow these steps to plan your system: 

• Determine network configuration
• Install and activate FactoryTalk View software

Tip: FactoryTalk Services Platform and FactoryTalk Alarms and Events software is installed 
along with FactoryTalk View and FactoryTalk Linx software. 

• Install FactoryTalk Linx software

Decide what type of alarm 
monitoring you need 

Follow these steps 
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• Install RSLinx Classic software
• Install and activate RSLogix software
• Update Logix 5000 firmware to V16 or later (optional if using Tag

Alarm and Event Servers)
• (optional) Install Microsoft SQL Server 2014 SP3 Express

• Decide what type of application you are building.
• Decide what type of alarm monitoring you need.
• Install and activate FactoryTalk software.
• Update Logix 5000 firmware to revision 16.20 or later (excluding 21 to

23), if you plan to use device-based alarm monitoring and alarm
instructions that are built into Logix 5000 controllers. If you do not
plan to use device-based alarm instructions, you can skip this step and
use tag-based alarm monitoring with a Tag Alarm and Event Server
instead.

Follow these procedures to install and activate the software products required 
for FactoryTalk Alarms and Events. 

IMPORTANT This guide describes how to set up a local station application. The procedure to set up a 
network station application or network distributed application is similar. This guide 
provides additional information about the two applications where it is necessary. See also 
Reference for building a distributed system on page 189. 

For more information about each software product, see its respective product 
Help. 

To use FactoryTalk Alarms and Events with a local station application or a 
network station application as part of a stand-alone FactoryTalk system, 
install all software on the same computer. Use this diagram only as a starting 
point--your own system will vary. 

What you need 

Install and activate 
FactoryTalk software 

Typical stand-alone system 
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For specific installation instructions, refer to the installation guide for each 
product. 

• To develop or run local station applications, install all the necessary
software components on one computer.

• To develop or run network station applications, install all the necessary
software components (except for data servers) on one computer.
Network station applications can connect to data servers that are
located on different machines.

• To develop or run network distributed applications, install different
combinations of software on each computer, depending on your
needs. For more information, see FactoryTalk Help. Click Start > All 
Programs > Rockwell Software > FactoryTalk Tools > FactoryTalk 
Help.

IMPORTANT This guide provides additional information about network distributed applications 
or network station applications where it is necessary. 

To set up a FactoryTalk system, install the following software: 

• FactoryTalk Services Platform
• FactoryTalk Activation
• FactoryTalk View Site Edition
• FactoryTalk Linx
• RSLinx Classic
• The Studio 5000 Logix Designer application (known previously as

RSLogix 5000 software)
• Update Logix 5000 firmware to revision 16.20 or later (excluding 21 to

23). If you plan to use device-based alarm monitoring see Decide what
type of alarm monitoring you need on page 26.

Tip: To take advantage of the new alarms functionality in the v24 firmware, we recommend you 
install FactoryTalk Services Platform v2.71 or later and update your controller firmware to 
revision 24 or later. 

If you plan to log historical alarm and event messages to a database, you must 
install Microsoft SQL Server software on the computer you want to use for 
logging. If you do not have Microsoft SQL Server software installed, see Install 
Microsoft SQL Server 2014 SP2 Express on page 165. 

Tip: If you already have Microsoft SQL Server installed, you may need to change the configuration 
options to log alarm and event messages. For configuration instructions, see Use an existing Microsoft 
SQL Server database on page 169. 

Install FactoryTalk software 

Install Microsoft SQL Server 
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Chapter 4 

Define device-based alarms in Logix 5000 
controllers 

To set up device-based alarm monitoring, you program alarms or alarm 
instructions that are available with the Logix Designer application (RSLogix 
5000 software version 16 or later), and download them to a Logix 5000 
controller. The controller detects alarm conditions and notifies alarms and 
events services of alarm states. Software components publish this information 
to a device server, where it can be logged to a database, and interacted from 
FactoryTalk View graphic displays. 

FactoryTalk Alarms and Events can handle many different types of alarms. 
The controller limits the alarms to Logix tag-based alarms and instruction-
based alarms. The instruction-based alarms include digital and analog alarms. 
An analog alarm instruction monitors two types of alarm conditions: Level 
and Rate of Change. A server tag-based alarm supports three alarm types: 
Digital, Level, and Deviation. 

Logix tag-based alarms associate alarm conditions with tags for Logix 5000 
controllers. Logix tag-based alarms monitor tag values to determine the alarm 
condition, but they are not part of the logic program and do not increase the 
scan time for a project. 

Tip: Logix tag-based alarms are supported only on Compact GuardLogix 5380, CompactLogix 5380, 
CompactLogix 5480, ControlLogix 5580, and GuardLogix 5580 controllers. 

A digital alarm instruction is based on the input rung state (in ladder logic) or 
on the alarm input (for function block). The trigger condition compares the 
value of the tag to either zero or one. 

An analog alarm defines a condition that evaluates a single analog tag against 
up to four limit values (high-high to low-low) and up to two rate of change 
limits (positive and negative). 

Tip: If your FactoryTalk application does not include Logix 5000 controllers, or if your controllers are not 
programmed with the alarm instructions included in the Logix Designer application (RSLogix 5000 
software version 16 or later), see Add an OPC Data Server for third-party controllers on page 47 and Add 
a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or third-party controllers on page 51. 

To receive device-based alarms, the alarm server (FactoryTalk Linx) 
establishes a subscription to the alarms in the Logix controller. The controller 
maintains a connection to each subscriber and monitors the status of that 
connection. 

Alarm buffering during loss 
of connection to the 
controller 
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As alarm state changes occur, the controller caches information such as 
timestamps, alarm state and associated tag values, and transmits the 
information to all of the subscribers. 

If any subscriber fails to confirm the receipt of the alarm information, or if the 
connection to a subscriber is not good, the controller stores the undelivered 
alarm information in a 100 KB buffer. Each subscriber has its own buffer and 
communication problems with one subscriber do not interfere with alarm 
delivery to other subscribers. When the buffer is full, newer alarm 
information is discarded and a FactoryTalk Diagnostics message is logged. 
The buffer is created when the subscriber establishes its initial connection, 
and is maintained for a length of time after a subscriber loses its connection. 
The length of time is specified in the Buffer Timeout setting on each 
FactoryTalk Linx device shortcut. See step 3, "Create a new shortcut to the 
controller," in Add a device server on page 39. 

IMPORTANT Firmware revision 21 to revision 23 do not support the new alarms functionality. The 
buffer timeout setting is not available to controllers with firmware revision 24 or later. For 
controllers with version 20 or earlier, we recommend that you do not change the default 
buffering time unless instructed by Technical Support. 

• Review Plan your system on page 25.
• Verify that you have installed and activated the software listed in the

next section under What you need on page 30.
• Verify that the Logix 5000 firmware has been updated to revision 16 or

later (excluding revisions 21 to 23).
Tip: To take advantage of the new alarms functionality in the revision 24 firmware, we 
recommend you install FactoryTalk Services Platform software version 2.71 or later, and update 
your controller firmware to revision 24 or later. 

• Logix Designer application (RSLogix 5000 software)
• ControlFLASH
• RSLinx Classic

Follow these steps to define a digital or analog alarm: 

• Plan your system
• Run Studio 5000 Logix Designer software
• Create a project
• For a digital alarm, define a boolean tag or a rung state on which to

alarm

For an analog alarm, define a analog tag on which to alarm

• Add a digital or analog alarm instruction
• Configure the digital or analog alarm properties
• Downland the project to the controller
• Test the alarm instruction
• Add a device server
• Add a data server

Before you begin 

What you need 

Follow these steps 
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Use Logix tag-based alarms to send alerts about specific events or conditions. 
Logix tag-based alarms are similar to instruction-based alarms that are 
created using alarm instructions (ALMA and ALMD), but Logix tag-based 
alarms do not affect the scan time of the project. 

Tip: Logix tag-based alarms are supported only on Compact GuardLogix 5380, CompactLogix 5380, 
CompactLogix 5480, ControlLogix 5580, and GuardLogix 5580 controllers. 

To define a Logix tag-based alarm: 
1. On the Controller Organizer, expand the Alarm Manager folder, right-

click Alarms, and select New Alarm.

To create an alarm in Tag Editor or in the Ladder, Sequential Function 
Chart, Function Block, or Structured Text editors, right-click a tag and
select Add Alarm for [tag].

2. In the Name box, enter a name for the alarm.
3. In the Input box, add the input tag for the alarm. If you launch the

New Alarm dialog box from a logic editor, the Input box is populated
with the tag that you right-clicked.

4. To enable the alarm, select the Required to be used and evaluated
check box. All new alarms are disabled by default.

5. Adjust other alarm settings as necessary.

An alarm definition is associated with an Add-On Instruction (AOI) or a 
defined data type. When a tag is created using a data type or an AOI that has 
alarm definitions, alarms are created automatically based on the alarm 
definitions. 

You can create an alarm definition for the following components: 

• Any scalar tag or parameter of an AOI.
• Any scalar member of a user-defined data type (UDT).
• Any scalar member of a system-defined data type (SDT).
• Any scalar member of a module-defined data type (MOT).

When a tag uses a data type that has alarm definitions associated with it, 
alarm conditions are automatically added for the tag based on its alarm 
definitions. 

When an AOI is based on an AOI definition, alarm conditions are 
automatically added for the AOI instance based on the alarm definitions 
associated with the AOI definition. 

To create an alarm definition: 
1. On the Controller Organizer, expand the Alarm Manager folder, right-

click Alarm Definitions, and select New Alarm Definition.

Define a Logix tag-based 
alarm 

Create an alarm definition 
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You can also right-click a scalar tag or parameter of an AOI or a scalar 
member of a data type and select Add Alarm Definition. 

2. In the Name box, enter a name for the alarm definition.
3. When creating an alarm definition for a UDT or AOI, in the Input box,

add an input tag. When creating an alarm definition for a data type,
add a data type member in the  Input box.

4. To enable all instances of the alarm, select the Required to be used and 
evaluated check box. All new alarms definitions are disabled by
default.

5. Adjust other settings as necessary.

You can download the program containing the Logix tag-based alarm to the 
controller and then use FactoryTalk View to test the alarm. 

1. If it is not already running, start RSLinx Classic to establish
communications between the controller and the Logix Designer
application (RSLogix 5000 software version 16 or later).

2. On the Logix Designer application menu, click Communications > 
Who Active.

3. Select the controller to which you want to download the project.
4. Click Download. At the prompt, click Download again. The controller

is placed in Program mode.
5. To switch the controller to run mode, click Communications > Run 

Mode.
6. To test the alarm, in FactoryTalk View Studio, create a FactoryTalk

Alarms and Events graphic object (for example, Alarm and Event
Summary) to read Logix tag-based alarms with the fully qualified
name.

Digital tags are either on or off. They have states instead of limits. The alarm 
trigger condition compares the value of the tag to the configured alarm state. 
An alarm can be triggered if the digital alarm is in one of these two states: 

• The rung evaluation or input tag is equal to zero
• The rung evaluation or input tag is not equal to zero

Tip: If your FactoryTalk application does not include Logix 5000 controllers, or if your controllers 
are not programmed with the alarm instructions included in the Logix Designer application 
(RSLogix 5000 software version 16 or later), see Add an OPC Data Server for third-party 
controllers on page 47 and Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or 
third-party controllers on page 51. 

This example uses the ladder logic editor that comes with the Logix Designer 
application (RSLogix 5000 software) to define a digital alarm. You can also 
configure digital alarms in function blocks or structured text. 

Step 1. Create a rung of logic that will trigger the alarm 
1. Create a new project with default settings. In this example, we use

West_Plant_Controller.

Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 

Download the program to 
controller and test the alarm 

Define an instruction-based 
alarm: digital 

Configure the digital alarm 
and download to the 
controller 
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2. In the left pane, expand the folders Tasks > MainTask > MainProgram,
and then double-click MainRoutine.

3. On the Language Element toolbar, click the Examine-on instruction

button  to add it to a rung on the ladder project.
4. At the top of the Examine-on instruction, click the question mark to

select it. On the File menu, click New Component, and then click Tag.
5. In the New Tag dialog box, type a name for the tag, choose BOOL as

the data type, and then click Create.

In our example, we name the tag alarm_active.

Step 2. Add a digital alarm instruction to the rung 
1. On the Language Element toolbar, click the Alarms tab, and then click

the ALMD button . The instruction block is placed in the ladder
logic.

2. Inside the alarm instruction, beside ALMD, select the question mark.
3. On the File menu, click New Component, and then click Tag.
4. In the dialog box that opens, type a name for the digital alarm tag, and

then click Create.

In our example, we named the tag DigitalAlarm1.

Step 3. Specify a tag for each of the digital alarm's operands, 
or just enter 0 

1. Inside the alarm instruction, select the ProgAck operand.
2. On the File menu, click New Component, and then click Tag.
3. In the New Tag dialog box, type a name for the tag, select BOOL as the

data type, and then click Create.

In our example, we named the tag DigitalAlarm1_Ack. For details
about using the New Tag dialog box, click Help.
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4. Create tags for the ProgReset, ProgDisable, and ProgEnable operands.
When you are finished, the alarm instruction should resemble the one
shown here:

Step 4. Configure the properties of the new digital alarm tag 
1. Inside the alarm instruction, click the Browse button (...).
2. In the ALMD Properties dialog box, specify configuration settings, and

then click OK. For help with specifying configuration settings, click
Help.

Tip: To create a text message with embedded variables for each alarm, click the Message box 
Browse button (...). At runtime, these messages appear in Alarm and Event graphic objects, 
such as the Alarm and Event Summary. The maximum length of an alarm message is 255 
characters. When importing alarm messages, the Logix Designer application (or RSLogix 5000 
software) will verify the message length and display a warning if the alarm message exceeds 
the character limit. 

Step 5. Download the program containing the ladder logic to the 
controller 

1. If it is not already running, start RSLinx Classic to establish
communications between the controller and the Logix Designer
application (RSLogix 5000 software version 16 or later).

2. On the Logix Designer application menu, click Communications > 
Who Active.

3. Select the controller to which you want to download the project.
4. Click Download. At the prompt, click Download again. The controller

is placed in Program mode.
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Step 6. Test the alarm instruction by switching to run mode and 
triggering the alarm 

1. On the Logix Designer application menu, click Communications > Run 
Mode. Click Yes to switch the controller to run mode.

2. To trigger the alarm, right-click the contact on the rung (the one
named alarm_active), and then click Toggle Bit. The contact should
change from a blue highlight to a green highlight.
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Step 7. Finish creating alarms, and next steps 
• Define additional digital alarms or analog alarms, using either ladder

logic, function blocks, or structured text, and download the logic to the
controller.

• When you finish defining alarms, create a device-based alarm server,
and then configure it to subscribe to events detected by the Logix 5000
controller. See Add a device server for Logix 5000, PLC-5, or SLC 500
controllers on page 39 for instructions.

An analog alarm defines a condition that evaluates a single analog tag against 
up to four limit values (high-high, hi, low, and low-low) and up to two rate of 
change limits (positive and negative). 

Tip: If your FactoryTalk application does not include Logix 5000 controllers, or if your controllers are not 
programmed with the alarm instructions included in the Logix Designer application (RSLogix 5000 
software version 16 or later), see Add an OPC Data Server for third-party controllers on page 47 and Add 
a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or third-party controllers on page 51. 

This example uses the Function Block editor that comes with the Logix 
Designer application (RSLogix 5000 software). You can also configure analog 
alarms in ladder logic or structured text. 

Step 1. Define a new routine 
1. Create a new project with default settings. In this example, we use

East_Plant_Controller.
2. Expand the Tasks folder in the left pane, right-click MainProgram,

click Add, and then click New Routine.
3. In the New Routine dialog box, type a name for the routine. We use

alarm_active.
4. In the Type list, click Function Block Diagram.
5. Select the Open Routine check box, and then click OK. The new routine

appears in the Tasks folder under MainRoutine and the routine opens
on the right side of the Logix Designer window.

Step 2. Build the function block logic 
1. To add an alarm block, go to the tabs in the center right area (Favorites,

Add-On, and so on) as shown in the following illustration. Scroll to the
right, and then click the Alarms tab.

2. On the toolbar, click the ALMA button to add an Analog Alarm 
block.

3. Using the same Alarm objects on the Language Element toolbar, click

the Input Reference icon .
4. Right-click the single question mark inside the symbol and then click

New Tag.

Define an instruction-based 
alarm: analog 

Configure the analog alarm 
and download it to the 
controller 
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5. In the New Tag dialog box, type a name for the tag and then click
Create.

In this example, we use AnalogAlarm1. The screen should resemble the
one shown in the following illustration:

6. Connect the input reference block to the Input of the ALMA block, as
shown in the following illustration, by dragging the block's contact
point to the contact point on the ALMA block.

Step 3. Configure the properties of the alarm block 
1. Click the Browse button (...) on the alarm block.
2. In the ALMA Properties dialog box, set the Input Levels as shown in

the following illustration and then click OK. To require that an
operator acknowledge the alarm at runtime, make sure the
Acknowledgement Required check box is selected.

Tip: To enter alarm messages and add variables for analog alarms, select the Messages tab. To 
create a text message with embedded variables, click the Browse button (...) beside the Level 
field, or beside the Rate of Change field. At runtime, alarm messages are displayed in Alarm 
and Event graphic objects such as the Alarm and Event Summary. 
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Step 4. Add a JSR instruction to the MainRoutine to run the function 
block 

1. Double-click MainRoutine to open it.
2. Right-click the first rung and then click Add Ladder Element.
3. In the Add Ladder Element dialog box, scroll down to the Program 

Control folder and then double-click the folder to expand the list of
controls.

4. Select JSR and then click OK.
5. In the JSR instruction, double-click Routine Name and then click

alarm_active.

6. On the toolbar, click the Save button to save the configuration. 

Step 5. Download the program to the controller 
1. If it is not already running, start RSLinx Classic to establish

communications between the controller and the Logix Designer
application (RSLogix 5000 software version 16 or later).

2. On the Logix Designer application menu, click Communications > 
Who Active.

3. Select the controller to which you want to download the project.
4. Click Download. At the prompt, click Download again. The controller

is placed in Program mode.
5. To switch the controller to run mode, click Communications > Run 

Mode.

Step 6. Finish creating alarms, and next steps 
• Define additional digital alarms or analog alarms using either ladder

logic, function block, or structured text, and download the logic to the
controller.

• When you finish defining alarms, create a device-based alarm server,
and then configure it to subscribe to events detected by the Logix 5000
controller. See Add a device server for Logix 5000, PLC-5, or SLC 500
controllers on page 39.
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Chapter 5 

Add a device server for Logix 5000, PLC-5, or SLC 
500 controllers 

Add a device server to your application to use: 

• Device-based alarms in Logix 5000 controllers.
• Tag-based alarms in PLC-5, SLC 500, or Logix 5000 controllers.

• If you are using device-based alarms, define your alarms, as described
in Define device-based alarms in Logix 5000 controllers on page 29.

• If you are using tag-based alarms, you create a controller program to
detect alarm conditions, and then associate those conditions with tags
that are monitored by the FactoryTalk Tag Alarm and Event Server.

• FactoryTalk Linx
• FactoryTalk View Studio or FactoryTalk Administration Console

Tip: This guide uses FactoryTalk View Studio to define a device server. You can also use 
FactoryTalk Administration Console. For more information, in the FactoryTalk Administration 
Console menu bar, select Help > Contents. 

Follow these steps to add a device server: 

• Define alarms
• Start FactoryTalk View Studio and open a Site Edition local application
• Add a new device server
• Configure the device server properties
• Open the Communication Setup editor
• Create a new shortcut to the Logix 5000 controller and configure

settings
• Set up graphic displays
• Set up historical alarm and event logging

In this section, you will create a Rockwell Automation device server 
(FactoryTalk Linx) and then configure it to subscribe to alarms that will be 
detected by a Logix 5000 controller. 

IMPORTANT If you are using third-party controllers, you do not need a device-based alarm server. 
Instead, go to Add an OPC Data Server for third-party controllers on page 47. 

Step 1. Create an application in FactoryTalk View Studio 
This example shows how to create a local station application. 

Before you begin 

What you need 

Follow these steps 

Add a device server 
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1. To start FactoryTalk View Studio, click Start > All Programs > Rockwell 
Software > FactoryTalk View > FactoryTalk View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Local Station) and then click Continue.

IMPORTANT FactoryTalk Alarms and Events is not supported for use with FactoryTalk View 
Machine Edition. 

3. In the New/Open Site Edition (Local Station) Application dialog box,
click the New tab.

4. In the Application name field, type a name for the new local station
application. In this example, we name the application My Local Site.

5. Leave the Description field blank, or type a description for the
application. For example, you can use this field to record revisions to
the application, or contact information for technical support.

6. If it is not already selected, select the default language for the
application. This is the language in which you are creating the
application.

7. Click Create.
8. In the Add Controller Instruction Faceplates dialog box, click Clear All

and then click OK.
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Tip: If you have cleared the Display this dialog when creating a new application check box, 
the Add Controller Instruction Faceplates dialog box does not open automatically. To open it 
manually, in the Explorer window right-click the HMI server, and then select Add Controller 
Instruction Faceplates. 

Step 2. Configure the device server 
1. In the Explorer window, right-click the new application My Local Site,

point to Add New Server, and then click Rockwell Automation Device
Server (FactoryTalk Linx).

2. In the FactoryTalk Linx Server Properties dialog box, click the General
tab, type a name for the new server, and then click Apply. In this
example, we name the server FTAE Server. Leave this dialog box open
for the moment.

3. Do one of the following:

• If you plan to use tag-based alarms, you can skip the rest of the steps
in this section, and go on to the next major step: "Step 3. Create a
new shortcut to the controller." Click OK to close the FactoryTalk 
Linx Server Properties dialog box.

• If you are using built-in alarm instructions in Logix 5000
controllers, continue with the steps in this section.
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4. On the Alarms and Events tab, select the Enable alarm and event
support check box.

5. Clear the Enable history check box and then click OK. For information
about historical logging, see Set up historical alarm and event logging
on page 101.

The new server is added to the My Local Site application:
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Step 3. Create a new shortcut to the controller 
1. In the Explorer window, double-click the new FactoryTalk Linx server

and then double-click Communication Setup.

2. In the Communication Setup dialog box, click the Add button, and
then type a name for the new shortcut. We use FTAE_Controller.

Some options in this dialog box might be different if you are using 
PLC-5 or SLC 500 controllers. 
The warning icon beside the OK button indicates that changing values 
in this dialog box at runtime can cause unexpected results. For details, 
click Help. 
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3. Skip this step if you do not plan to use Logix 5000 controllers with
built-in alarm instructions. In the Subscribe to list, click All Alarms & 
Events Notification Messages or Only Alarms Notification Messages
to enable Alarms and Events.

If you do not see the Subscribe to list, then Enable alarm and event 
support was not selected in the previous step 4.

Tip: Set Buffer Timeout (min.) for the length of time (zero to 120) you want to cache alarm 
information if the connection to the controller is lost. To disable alarm buffering, set the value to 
zero. See Alarm Buffering during loss of connection on page 29. 

4. On the Primary tab, expand the list of networks and devices until the
controller you plan to use is visible, and then click the controller.

5. To set the path to the primary controller, click the Apply button.
6. To save the shortcut configuration and close the Communication 

Setup dialog box, click OK.
IMPORTANT FactoryTalk Alarms and Events server redundancy is only supported in network 

station applications and network distributed applications. 

Step 4. Finish creating data servers, and next steps 
1. If your FactoryTalk application includes third-party OPC-DA

controllers, add an OPC Data Server, create a tag-based alarm server,
and then define alarms. See Add an OPC Data Server for third-party
controllers on page 47 and Add a tag-based alarm server for Logix
5000, PLC-5, SLC 500, or third-party controllers on page 51.

2. If your FactoryTalk application is communicating with PLC-5 or SLC
500 controllers, or Logix 5000 controllers that are not using built-in
alarm instructions, you must add a device server (FactoryTalk Linx) to
your application and then create a tag-based alarm server and define
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alarms. See Add a tag-based alarm server for Logix 5000, PLC-5, SLC 
500, or third-party controllers on page 51. 

3. After you create data servers and alarms, add FactoryTalk Alarms and
Events objects to graphic displays. See Set up graphic displays on page
59.

4. If your FactoryTalk network distributed application or network station
application plan calls for data redundancy, you will want to configure
your device-based alarm server for redundancy. We recommend
leaving this step until after the FactoryTalk application is fully
configured and all HMI features have been tested using non-
redundant servers. Adding data server redundancy does not affect the
configuration of the graphic displays in the HMI application. See
Configure redundancy for alarms and events for more information. on
page 119 

IMPORTANT FactoryTalk data server redundancy is only supported in network station 
applications and network distributed applications. 
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Chapter 6 

Add an OPC data server for third-party 
controllers 

To monitor alarms in a third-party controller, create a controller program to 
detect alarm conditions and communicate them through tags. Use an OPC 
Data Server (for example, KEPWare server) to obtain tag values from the 
controller, and use a Tag Alarm and Event Server to monitor those tags for 
alarm conditions. 

This chapter shows an example using RSLinx Classic as an OPC Data Server. 
In most situations FactoryTalk Linx is used to communicate with a PLC-5 or 
SLC 500 controller. However, at times RSLinx Classic is used to communicate 
with a controller that is bridged over Ethernet to a DH+ or DH-485 network. 

• Review Plan your system on page 25.
• Verify that you have installed and activated the software listed under

What you need on page 47.

• PLC-5, SLC 500 or third-party OPC-DA programmable controller
• RSLogix 5 or RSLogix 500 software
• RSLinx Classic software
• FactoryTalk Linx software
• FactoryTalk View Studio or FactoryTalk Administration Console

Follow these steps to add a data server: 

• Plan your system
• Run RSLinx Classic and configure a device driver
• Run RSLogix software and configure system
• Develop a ladder file and assign symbols to tags
• Create OPC topics
• Run FactoryTalk View Studio
• Add a link between controller tags and FactoryTalk Directory
• Add a tag-based alarm server for PLC, SLC, or third-party OPC-DA

controllers and Logix 5000* controllers

* Logix 5000 controllers that have not been programmed with alarm
instructions in RSlogix 5000 V16 or later

When you add a data server to an application or area, tags published by the 
data server can be accessed by any client--in this case, the Tag Alarm and 
Event Server. 

IMPORTANT This guide uses FactoryTalk View Studio to add a data server. You can also use 
FactoryTalk Administration Console. For more information, select Help > Contents from 
the FactoryTalk Administration Console window. 

Before you begin 

What you need 

Follow these steps 

Add an OPC data server to 
an application 
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Step 1. Open an existing application in FactoryTalk View Studio 
1. To run FactoryTalk View Studio, click Start > All Programs > Rockwell 

Software > FactoryTalk View > FactoryTalk View Studio.
2. In the Application Type Selection window, select View Site Edition 

(Local Station) and then click Continue.
3. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab and select the application you created in Add a
device server for Logix 5000, PLC-5, or SLC 500 controllers on page 39
(we use My Local Site). 

Step 2. Add a data server 
1. In the Explorer window, right-click the application, point to Add New 

Server, and then click OPC DA Server.
2. In the OPC Data Server Properties dialog box, type a name for the

server. We use My OPC Server.
3. Beside the OPC Server name (ProgID) field, click the Browse button.
4. In the Available OPC Data Servers dialog box, select RSLinx OPC 

Server, and then click OK.
Tip: When creating a network station application or network distributed application, select 
RSLinx Remote OPC Server. 

5. Click OK to close the OPC Data Server Properties dialog box.
6. Next, add a Tag Alarm and Event Server and define alarm conditions.

See Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or
third-party controllers on page 51.

7. If your FactoryTalk network station application or network distributed
application plan calls for data redundancy, you will want to configure
your tag-based alarm server for redundancy. We recommend
completing this step after the FactoryTalk application is fully
configured and all HMI features have been tested using non-
redundant servers. Adding data server redundancy does not affect the
configuration of the graphic displays in the HMI application.
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IMPORTANT FactoryTalk Alarms and Events server redundancy and data server redundancy 
are only supported in network station applications and network distributed 
applications. 
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Chapter 7 

Add a tag-based alarm server for Logix 5000, 
PLC-5, SLC 500, or third-party controllers 

FactoryTalk Tag Alarm and Event Servers provide software-based alarms and 
events. Use tag alarm and event servers to monitor alarm conditions in Logix 
5000 controllers, PLC-5, SLC 500, or third-party OPC-DA programmable 
controllers. 

Tip: If your FactoryTalk system does not include PLC, SLC, or third-party controllers, you can skip this 
chapter. 

A FactoryTalk Tag Alarm and Event Server provides a link between a hardware 
device that contains data and the FactoryTalk Directory. This includes third-
party controllers. All that is required is a data server (such as KEPWare) to 
communicate with the controller. 

FactoryTalk Tag Alarm and Event Servers can be used to provide an 
alternative to device-based alarms--alarms provided by devices such as Logix 
5000 controllers or sensors using built-in alarm instructions. 

• If you are using third-party controllers, you do not need a device-based
alarm server. Instead, go to Add an OPC Data Server for third-party
controllers on page 47.

• Logix 5000 controllers, PLC-5, or SLC 500 devices communicating
through Rockwell Automation device servers (FactoryTalk Linx)

• RSLogix 5 or RSLogix 500 software
• FactoryTalk Linx, RSLinx Classic (or RSLinx Classic for bridging from

Ethernet to DH+ or DH-485 networks)
• FactoryTalk View Studio or FactoryTalk Administration Console

Follow these steps to add a tag-based alarm server: 

• Add a data server for PLC, SLC, third-party, or Logix 5000 controllers
Tip: To user tag-based alarms in PLC-5, SLC 500, or Logix 5000 controllers, you must add a 
device server (FactoryTalk Linx) to your application. 

• Run FactoryTalk View Studio
• Add a new device server (FactoryTalk Linx)
• Add a new tag alarm and event server
• Configure the server properties
• Set up conditions for triggering alarms in your FactoryTalk system
• Add Alarm and Event objects to graphic displays
• Set up graphic displays

In this section, you will create a Rockwell Automation device server 
(FactoryTalk Linx) and then configure it to subscribe to alarms that will be 

Before you begin 

What you need 

Follow these steps 

Create an application 
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detected by a Logix 5000 controller. In this example, the Rockwell Automation 
device server (FactoryTalk Linx) is used as a data server for tag values, not as 
an alarm server. 

Create an application in FactoryTalk View Studio 
Tip: If you created a local station application previously, you can skip the steps in this section. Open the 
application you created and go on to the next section Add a data server. 

This example shows how to create a local station application. 

1. To start FactoryTalk View Studio, in Windows, click Start > All 
Programs > Rockwell Software > FactoryTalk View > FactoryTalk
View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Local Station) and then click Continue.

IMPORTANT FactoryTalk Alarms and Events is not supported for use with FactoryTalk View 
Machine Edition. 

3. In the New/Open Site Edition (Local Station) Application dialog box
click the New tab.

4. In the Application name field, type a name for the new application. In
this example, we name the application My Local Site.

5. Leave the Description field blank, or type a description for the
application. For example, you can use this field to record revisions to
the application, or contact information for technical support.

6. If it is not already selected, select the default language for the
application. This is the language in which you are creating the
application.

7. Click Create.



Chapter 7 Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or third-party controllers 

Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 53 

8. In the Add Controller Instruction Faceplates dialog box, click Clear All
and then click OK.

Tip: If you have cleared the Display this dialog when creating a new application check box, 
the Add Controller Instruction Faceplates dialog box does not open automatically. To open it 
manually, in the Explorer window right-click the HMI server and then select Add Controller 
Instruction Faceplates. 

Step 1. Configure the device server (FactoryTalk Linx) 
When you add a data server to an application or area, tags published by 
the data server can be accessed by any client--in this case, the Tag 
Alarm and Event Server. 

IMPORTANT This guide uses FactoryTalk View Studio to add a data server. You can also use 
FactoryTalk Administration Console. For more information, select Help > Contents 
from the FactoryTalk Administration Console window. 

In this example a device server (FactoryTalk Linx) is added to the 
application to act as a data server. 

1. In the Explorer window, right-click the application (My Local Site),
point to Add New Server, and then click Rockwell Automation Device
Server (FactoryTalk Linx).

2. In the FactoryTalk Linx Server Properties dialog box, click the General
tab, type a name for the server, and then click Apply. In this example,
we name the server FTAE Server.

Add a data server 
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The new server is added to the My Local Site application: 

Step 2. Create a new shortcut to the controller 
Tip: If you already created a shortcut to the controller in a previous chapter, you can skip this step. 

1. In the Explorer window, double-click the new FactoryTalk Linx server
and then double-click Communication Setup.
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2. In the Communication Setup dialog box, click the Add button and
then type a name for the new shortcut. We use FTAE_Controller.

Some options in this dialog box might be different if you are using 
PLC-5 or SLC 500 controllers. 
The warning icon beside the OK button indicates that changing values 
in this dialog box at runtime can cause unexpected results. For details, 
click Help. 

3. On the Primary tab, expand the list of networks and devices until the
controller is visible, and then click the controller. To set the path to the
primary controller, click the Apply button.

4. To save the shortcut configuration and close the Communication 
Setup dialog box, click OK.

To create a server and define alarm conditions that monitor tags for PLC-5, 
SLC 500 controllers, or Logix 5000 controllers, complete the following steps. 

These instructions apply to FactoryTalk View Studio. For help with 
FactoryTalk Administration Console, click Start > All Programs > Rockwell 
Software > FactoryTalk Tools > FactoryTalk Help. 

Add a Tag Alarm and Event Server 
1. In the Explorer window, right-click the application. Point to Add New 

Server, and then click Tag Alarm and Event Server.
2. In the Tag Alarm and Event Server Properties dialog box, click the

General tab.

Add a Tag Alarm and Event 
Server 
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3. Type a name for the server, and then click OK. In this example, we use
TagAE.

4. On the Priorities and History tab, clear the Enable history check box.

The Priorities and History tab is used to configure alarm and event
logging. Set up historical alarm and event logging on page 101
describes how to set up alarm logging for a Tag Alarm and Event
Server.

5. To create the Tag Alarm and Event Server and close the dialog box,
click OK.

After creating a Tag Alarm and Event Server, define the conditions that will 
trigger alarms at runtime. 

This example shows how to create a digital alarm in a Tag Alarm and Event 
Server. 

1. In the Explorer window, expand the TagAE server, and then double-
click Alarm and Event Setup.

2. In the Alarm and Event Setup dialog box, click the New button on 
the toolbar, and then click Digital.

3. In the Digital Alarm Properties dialog box, type a name for the alarm.
In this example we use Valve1FTO.

Define alarm conditions 
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4. To select an Input Tag for the alarm, click the Browse button (...), and
then expand the folder tree until you can select the online tag you plan
to monitor.

5. Select the tag you plan to monitor and then click OK. In this example
we used Valve1FTO_alm.

6. In the Digital Alarm Properties dialog box, type a message. In this
example, in the Message field we type The valve failed to open.

You can also embed variables within the message. For details, click
Help on any tab in the Alarm Setup dialog box.

7. To close the Digital Alarm Properties dialog box, click OK.
8. To save the alarm and start monitoring for the alarm condition, click

Save.

Do the following: 

1. Define additional alarms and (optionally) define alarm groups.
2. After you define alarms and groups, you can add FactoryTalk Alarms

and Events objects to graphic displays. See Set up graphic displays on
page 59.

3. If your FactoryTalk network station application or network distributed
application plan calls for data redundancy, you will want to configure
your tag-based alarm server and tag data servers for redundancy. We
recommend completing this step after the FactoryTalk application is
fully configured and all HMI features have been tested using non-
redundant servers. Adding data and alarm server redundancy does not
affect the configuration of the graphic displays in the HMI application.

Next steps 
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See Configure redundancy for alarms and events on page 119 for more 
information. 

IMPORTANT FactoryTalk Alarms and Events redundancy and data server redundancy are only 
supported in network station applications and network distributed applications. 
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Chapter 8 

Set up graphic displays 

Create graphic displays in FactoryTalk View Studio. These are containers for 
objects, such as the FactoryTalk Alarm and Event Summary object. Add 
FactoryTalk Alarms and Events objects to graphic displays so that an operator 
can monitor and interact with device-based, tag-based alarms, and diagnostic 
events at runtime. 

Other graphic objects (for example, objects representing equipment) can be 
animated (for example, to change color) using FactoryTalk View Site Edition 
expression functions that monitor the state of alarms. See Use color 
animation to indicate alarm state changes on page 74. Also see FactoryTalk 
View Site Edition Help. 

This section describes how to create graphic displays, and then create and 
configure the FactoryTalk Alarms and Events graphic objects and macros that 
determine how the graphic displays open in the FactoryTalk View Site Edition 
Client. This section is one example of how you might create your graphic 
displays. 

• Define the alarms you plan to use, as described in Define device-based
alarms in Logix 5000 controllers on page 29.

• Add the required device server, as described in Add a device server for
Logix 5000, PLC-5, or SLC 500 controllers on page 39 or Add a tag-
based alarm server for Logix 5000, PLC-5, SLC 500, or third-party
controllers on page 51.

• FactoryTalk Linx software
• FactoryTalk View Studio software

Follow these steps to set up graphic displays: 

• Add a device server or add a tag-based alarm server
• Run FactoryTalk View Studio and open an application
• Create a graphic display
• Add an Alarm and Event Summary object
• Configure the object's properties
• Create a graphic display
• Add an Alarm and Event Banner object
• Configure the object's properties
• Create a startup macro
• Create a graphic display
• Add an Automatic Diagnostic Event Summary object
• Configure the object's properties

Before you begin 

What you need 

Follow these steps 
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• Animate a display with expressions
• Monitor and interact with alarms during runtime
• Set up historical alarm and event logging

Create a graphic display to host FactoryTalk Alarms and Events objects, such 
as the Alarm and Event Summary. 

Step 1. Open an existing application in FactoryTalk View Studio 
1. To run FactoryTalk View Studio, click Start > All Programs > Rockwell 

Software > FactoryTalk View > FactoryTalk View Studio.
2. In the Application Type Selection window, select View Site Edition 

(Local Station) and then click Continue.
3. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab, and select the application you created in Add a
device server for Logix 5000, PLC-5, or SLC 500 controllers on page 39
(we used My Local Site). 

Create a graphic display 
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Step 2. Create a graphic display to host FactoryTalk Alarms and 
Events objects 

1. In the Explorer window, expand the Graphics folder, right-click
Displays, and then click New.

A blank display appears in the workspace. Next, add Factory Talk 
Alarm and Event objects to the graphic display. 

Use the Alarm and Event Summary object to view and interact with a 
summary of all the current alarms and events in an application. You can 
acknowledge, suppress, disable, shelve, or unshelve alarms. 

Tip: You cannot use the Alarm and Event Summary to enable or turn alarm suppression off. To enable or 
turn alarm suppression off, use the Alarm Status Explorer. See Monitor alarms and events on page 87. 
To silence an alarm, use the Alarm and Event Banner. 

You can use FactoryTalk Security to control which users can acknowledge, 
enable, disable, reset, suppress, shelve, or unshelve alarms at runtime in an 
application (or in an area). To do this, right-click the application (or area) and 
then click Security. For details, see the FactoryTalk Security System Configuration 
Guide. 

Create an Alarm and Event 
Summary 
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Step 1. Add an Alarm Summary to a graphic display 
1. On the Objects menu, point to Alarm and Event, click Summary (or in

the toolbox, select Alarm and Event Summary), and then place the
cursor approximately where the object is to be on the display.

2. Hold the left mouse button down and drag it to create a rectangle the
size that the Alarm and Event Summary object should be.

3. When the object is the desired size, release the left mouse button. The
Alarm and Event Summary object is drawn on the display.

Step 2. Change the settings of the Alarm and Event Summary display 
1. On the menu bar, click Edit > Display Settings. 
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Tip: In any application, do not include more than two graphic displays that have Cache After 
Displaying and Always Updating set because these options can consume large numbers of 
processor cycles. 

2. In the Display Settings dialog box, on the Properties tab, make the
following changes and then click OK.

• Under Cache After Displaying, click Yes and then select the Always 
Updating check box.

When you set Cache After Displaying to Yes, the display stays in
memory cache when you close it. This shortens the time required to
open the graphic display the next time.
When you select the Always Updating check box, the display
continues to be updated with changes in alarm states when it is
cached. This shortens the time necessary to update the Alarm and
Event Summary with current alarms when you open it again.
If Cache After Displaying is set to No, and the Always Updating
check box is cleared, every time you close the graphic display, all
alarms are removed from the Alarm and Event Summary. When you
re-open the graphic display, the Alarm and Event Summary is blank,
and then begins to receive the most recent alarms when they occur.

• Clear the Title Bar check box.
• Select the Size to Main Window at Runtime check box.
• Select the Allow Display to be Resized check box.
• Under When Resized, select the Scale check box is if it is not already

selected.

Step 3. Save the display 
1. On the File menu, click Save.

2. In the Save dialog box, type a name for the new display and then click
OK.

We use Alarm and Event Summary in this example.

3. Close the graphic object.
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This section describes how to add an Alarm and Event Banner object to a 
graphic display, and then create a startup macro that docks the Banner to the 
bottom of the FactoryTalk View Site Edition Client window. 

Step 1. Create a new graphic display 
1. In the Explorer window, expand the Graphics folder.
2. Right-click Displays, and then click New.

Step 2. Add an Alarm and Event Banner object to the display 
1. On the Objects menu, point to Alarm and Event, click Banner (or, in

the toolbox, select Alarm and Event Banner), and then place the
cursor approximately where the object is to be on the display.

2. Hold the left mouse button down and drag it to create a rectangle the
size that the Alarm and Event Banner should be.

3. When the object the desired size, release the left mouse button. The
Alarm and Event Banner object is drawn on the display.

Create an Alarm and Event 
Banner display 
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4. Resize the graphic display so that the Banner fills the graphic display
(do not leave white space). Do so because the Banner displays no more
than five alarms at a time.

Step 3. Configure the properties of the Alarm and Event Banner 
1. To open the Alarm and Event Banner Properties dialog box, double-

click the Alarm and Event Banner object. For details about all of the
properties in the dialog box, click Help.

2. On the General tab, click the Browse button (...) under Alarm and 
Event Summary command.

This opens the Command Wizard where you will create a command to 
start the Alarm and Event Summary graphic display from the Alarm 
and Event Banner. 
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3. Scroll down the list of commands on the right side of the wizard, select
Display, and then click Next.

4. In the File list, click Alarm and Event Summary.

5. Select the Window Position check box. Scroll down the list on the right
and then click Centered of the screen.
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6. Click Finish to save the Display command and add it to the Alarm and 
Event Banner Properties dialog box.

7. Click OK to close the dialog box.

Step 4. Change the display settings for the Alarm and Event Banner 
display 

1. On the Edit menu, click Display Settings.



Chapter 8 Set up graphic displays 

68 Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 

2. In the Display Settings dialog box, on the Properties tab, make the
following changes, and then click OK:

• Clear the Title Bar check box.
• Select Size to Main Window at Runtime.
• Select Allow Display to be Resized.
• Under When Resized, select Scale if it is not already selected.

3. The Alarm and Event Banner graphic display is always visible because
it is docked. You do not need to turn on Cache After Displaying, as you
did for the Alarm and Event Summary object. See step 2: "Change the
settings of the Alarm and Event Summary display" in Create an Alarm
and Event Summary on page 61.

Step 5. Save the graphic display 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the graphic display and then

click OK.

In this example, we use Alarm and Event Banner.

3. Close the graphic display.
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This section describes how to create a startup macro. You will use the macro 
when you configure the FactoryTalk View Site Edition Client. See Monitor 
and interact with alarms at runtime on page 83. 

Step 1. Configure a startup macro 
This startup macro docks the Banner display to the bottom of the FactoryTalk 
View SE Client window. 

1. In FactoryTalk View Studio, in the Explorer window, right-click
Macros and then click New to open the editor.

2. To open the Command Wizard, double-click anywhere in the body of
the macro editor.

Create a startup macro for 
the Banner display 
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3. In the Command Wizard, scroll down the list of commands on the
right side of the wizard, click Display, and then click Next.

4. In the File list, click Alarm and Event Banner.

5. Select the Window Position check box. Scroll down the list on the right
and then select Docked to the bottom.

6. To save the Display command and add it to the macro, click OK.

Step 2. Save the macro 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the new macro and then click

OK. In this example, we use Start Alarm and Event Banner.

Use the Automatic Diagnostic Event Summary object to subscribe to and 
show diagnostic events collected by Rockwell Automation controllers via 

Create an Automatic 
Diagnostic Event Summary 
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Ethernet. It is enabled by the Automatic Diagnostics feature. Automatic 
Diagnostics is supported only on Compact GuardLogix 5380, CompactLogix 
5380, CompactLogix 5480, ControlLogix 5580, and GuardLogix 5580 
controllers, and the firmware revision must be 33 or later. With the Automatic 
Diagnostic Event Summary, you can suppress, unsuppress, filter, and sort 
diagnostic events at runtime. 

You can use FactoryTalk Security to control which users can suppress or 
unsuppress events at runtime in an application (or in an area). To do this, 
right-click the application (or area) and then click Security. For details, see the 
FactoryTalk Security System Configuration Guide. 

Step 1. Create a new graphic display 
1. In the Explorer window, expand the Graphics folder.
2. Right-click Displays, and then click New.

Step 2. Add an Automatic Diagnostic Event Summary object to the 
display 

1. On the Objects menu, point to Alarm and Event, click Automatic 
Diagnostic Event Summary (or, in the toolbox, select Automatic 
Diagnostic Event Summary), and then place the cursor approximately
where the object is to be on the display.

2. Hold the left mouse button down and drag it to create a rectangle the
size that the Automatic Diagnostic Event Summary should be.
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3. When the object the desired size, release the left mouse button. The
Automatic Diagnostic Event Summary object is drawn on the display.

Step 3. Configure the properties of the Automatic Diagnostic Event 
Summary 

• To open the Automatic Diagnostic Event Summary Properties dialog
box, right-click the Automatic Diagnostic Event Summary object. For
details about all of the properties in the dialog box, click Help.

Step 4. Change the display settings for the Automatic Diagnostic Event 
Summary display 

1. On the Edit menu, click Display Settings.
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2. In the Display Settings dialog box, on the Properties tab, make the
following changes, and then click OK:

• Clear the Title Bar check box.
• Select Size to Main Window at Runtime.
• Select Allow Display to be Resized.
• Under When Resized, select Scale if it is not already selected.

Step 5. Save the graphic display 
1. On the File menu, click Save.

2. In the Save dialog box, type a name for the graphic display and then
click OK.
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In this example, we use Automatic Diagnostic Event Summary. 

3. Close the graphic display.

In this section, you use alarm expressions in FactoryTalk View to animate a 
rectangle on a graphic display so that it changes color when the alarm state 
changes at runtime: 

• If there are active unacknowledged alarms, the rectangle flashes red.
• If all active alarms have been acknowledged, the rectangle is a steady

red.
• If there are no active alarms but there are normal unacknowledged

alarms, the rectangle is yellow.
• If there are no active or unacknowledged alarms, the rectangle is

green.

Step 1. Create a new graphic display 
1. In the Explorer window, expand the Graphics folder.
2. Right-click Displays, and then click New.

Step 2. Add an Alarm and Event Summary to the graphic display 
1. On the Objects menu, point to Alarm and Event, and then click

Summary (or in the toolbox, click Alarm and Event Summary).
2. Hold the left mouse button down and drag it to create a rectangle the

size that the Alarm and Event Summary object should be.
3. When the object is the desired size, release the left mouse button. The

Alarm and Event Summary object is drawn on the display.

4. If necessary, resize either the Alarm and Event Summary object or the
graphic display to expose enough white space at the top, bottom, or on

Use color animation to 
indicate alarm state 
changes 
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one side to add a rectangle object that will be the alarm status 
indicator. 

5. On the Objects menu, point to Drawing and then click Rectangle.
6. In the graphic display, hold down the left mouse button and then drag

the mouse to draw a box for the alarm status indicator.

Step 3. Add an expression to animate the rectangle 
1. Right-click the rectangle, point to Animation and then click Color.

To create an expression for the color animation, you can compose the
expression step by step, as explained in the following steps, or you can
type the following expression in the Expression box:

If AE_InAlmUnackedCount( "*" ) > 0 Then 0 Else 
If AE_InAlmAckedCount( "*" ) > 0 Then 1 Else 
If AE_NormalUnackedCount( "*" ) > 0 Then 2 Else 3 

Tip: In the preceding expression, "*" means include all alarms that are in the same location 
(area) as the HMI server. If the preceding expression is used in a network station application 
or network distributed application with areas, the expression would include all alarms from 
the alarm servers that are located in the same area as the HMI server.  
If you want to include alarms from other areas, use the absolute path syntax. For example, 
("/AreaName::*"). 
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If you type the expression instead of composing it, skip to the next 
major step "Step 4. Set up colors for the alarm states" to apply colors to 
each state. 

2. In the Animation dialog box, click Expression.
3. In the Expression Editor, click the If button and then click If to add

the IF condition.

4. In the Expression Editor, click Functions.
5. In the Functions dialog box, in the list of Function Categories, click

Alarm and Event.

The HMI Tag Alarming category contains functions that apply only to
HMI tags located in an HMI server. Because our alarm data is coming
from a controller or a FactoryTalk Tag Alarm and Event Server, we use
the Alarm and Event expressions.
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6. In the list of functions on the right, click
AE_InAlmUnackedCount(AlarmName), and then click OK.

7. In the Expression Editor, the AE_InAlmUnackedCount( ) function
appears in the Expression box, with the cursor between the
parentheses. Next, type "*" to return a count of all alarms that are in
the same location (area) as the HMI server and are in the In Alarm and
Unacknowledged state. Next, move the cursor to the right of the
closing parenthesis.

To count the number of instances of a specific alarm, you can type a
tag name instead of the asterisk.
To include alarms from other areas, use the absolute path syntax. For
example,
("/AreaName::*").

8. Click Relational and then click > GT for greater than.

9. In the Expression box, type 0, click If and then click Then to add a
THEN condition.

This completes the IF condition: "If the number of In Alarm,
Unacknowledged alarms is greater than 0 . . ."

10. In the Expression box, type 0, click If and then click Else to add an
ELSE condition.
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This completes the THEN condition: "If the number of In Alarm, 
Unacknowledged alarms is greater than 0, then animate the rectangle 
to show the colors for state 0." 

11. Follow the same process, substituting the necessary selections to add
the remaining two expressions, and then click OK.

If AE_InAlmAckedCount( "*" ) > 0 Then 1 Else (animates the 
rectangle to show the colors for state 1) 
If AE_NormalUnackedCount( "*" ) > 0 Then 2 Else 3 (animates the 
rectangle to show the colors for state 2. If none of the conditions are 
true, the expression animates the rectangle to show the colors for 
state 3.) 

Step 4. Set up colors for the alarm states 
This step describes how to set up colors for the rectangle for each solution to 
the expression. 

1. In the Animation dialog box, under Expression, click state A.

2. In the Value box, type 0.
3. Beside Fill, select the Blink check box. A colored box is displayed so

that you can specify an alternative color.
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4. Beside Fill, make sure the colored boxes are set to red (for the fill color)
and black (for the blinkalternative color).

5. Set up the colors for the remaining states:

• State B: Value = 1, Line = Black, Fill = Red
• State C: Value = 2, Line = Black, Fill = Yellow
• State D: Value = 3, Line = Black, Fill = Green

6. When you are finished setting up the colors, click Apply and then click
Close.

Step 5. Save the graphic display 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the graphic display and then

click OK.

In this example, we use Alarm Status Indicator.

Step 6:  Test run the display 
1. On the View menu, click Test Display, or click the Test Display button

(shown at left) on the toolbar.

If there are unacknowledged alarms whose alarm condition is In
Alarm, the rectangle flashes red.
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2. Right-click one of the alarms, and then click Ack All. Because all active
alarms have been acknowledged, the rectangle changes to a steady red.

3. Continue experimenting to observe the effects of acknowledging
alarms:

• If there are no active alarms, but there are normal unacknowledged
alarms, the rectangle is yellow.

• If there are no active or unacknowledged alarms, the rectangle is
green.

4. When you are finished, on the View menu, click Edit Display, or click

the Edit Display button  on the toolbar.
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Do one of the following: 

• Use the graphic displays you just created to monitor and interact with
alarms and events. See Monitor and interact with alarms at runtime on
page 83.

• Set up historical alarm and event logging. See Set up historical alarm
and event logging on page 101.

Next steps 
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Chapter 9 

Monitor and interact with alarms at runtime 

To interact with alarms and events at runtime, set up a FactoryTalk View Site 
Edition Client and configure one or more graphic displays that host Alarm 
and Event objects. Next, run the client and then monitor the alarms and 
events that are shown. 

• Be sure you have defined alarms as described in Define device-based
alarms in Logix 5000 controllers on page 29.

• Add the appropriate device server as described in Add a device server
for Logix 5000, PLC-5, or SLC 500 controllers on page 39 or Add a tag-
based alarm server for Logix 5000, PLC-5, SLC 500, or third-party
controllers on page 51.

• Set up and configure any graphic display objects as described in Set up
graphic displays on page 59.

• FactoryTalk Linx software
• FactoryTalk View SE software
• FactoryTalk View SE Client software

Follow these steps to monitor and interact with alarms during runtime: 

• Set up graphic displays
• Run FactoryTalk View SE Client wizard and create a configuration file
• Run the FactoryTalk View SE Client
• Monitor graphic displays with Alarm and Event objects
• Acknowledge an alarm
• Disable and enable an alarm
• Suppress and unsuppress an alarm
• Set up historical alarm and event logging

To run an application and monitor graphic displays for alarm messages, start 
the FactoryTalk View Site Edition Client. 

IMPORTANT For this example, be sure that the controller is running the West_Plant_Controller program 
that we created in Chapter 3, and that you have tripped the alarm (right-click the rung 
contact and then click Toggle Bit). 

Before you begin 

What you need 

Follow these steps 

Create and then run a 
FactoryTalk View Client 
configuration 
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Step 1. Create a FactoryTalk View Site Edition Client configuration file 
1. To open the FactoryTalk View SE Client Wizard, in Windows, click

Start > All Programs > Rockwell Software > FactoryTalk View >
FactoryTalk View Site Edition Client.

2. In the FactoryTalk View SE Client Wizard, click Create a FactoryTalk
View SE Client configuration file.

3. On the File name and location page, in Client file name, type a name
for the configuration file. In this example, we used Alarms and Events
Demo. Select a path for the configuration file and click Continue.
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4. On the Startup components page, select Local Station.

In the Connect to the application list, select the name of the 
application you plan to connect to. In this example, use the My Local 
Site application created in Set up graphic displays on page 59. 
In the Startup macro list, select Start Alarm and Event Banner, and 
then click Advanced. 

5. On the Client window properties page, configure how the FactoryTalk
View SE Client window will look at runtime. In this example, we
entered Show Me Alarms in the Title bar text box. At runtime, this text
is displayed at the top of the Client window. Click Security and 
debugging.
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6. On Security and debugging page, you can configure the Client to log
out automatically after a period of inactivity.

7. Click Save, and then Run.

The Client window opens with the Alarm and Event Banner docked at
the bottom.

Step 2. Open the Alarm and Event Summary from the Alarm and Event 
Banner 

In the Alarm and Event Banner, click the Alarm and Event Summary 
button (shown at left). The Alarm and Event Summary opens, and is 
similar to the following graphic display. 
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Step 3. Next steps 
Do either of the following: 

• Monitor and interact with alarms and events as shown in the next
section.

• Set up historical logging for alarms and events using the graphic
displays and startup macros created in this chapter and in Set up
graphic displays on page 59. See Set up historical alarm and event
logging on page 101.

The data fields in the Alarm and Event Banner window are organized in 
columns, and represent various alarm and event data. At runtime, only the 
columns that were configured at design time to be visible are displayed in the 
Alarm and Event Banner. 

In this example, the alarm list shows these columns: 

• Priority - Medium
• Alarm State - In Alarm and Unacknowledged
• Event time and date stamp
• Message

The status bar shows (from left to right): 

The connection status of the Tag Alarm and Event Server -- 
whether connected or disconnected from the Alarm and Event Banner. 
The green icon shows that the Tag Alarm and Event Server is 
connected. When disconnected, the icon flashes red. 

The number of alarms that are In Alarm and 
Unacknowledged 

The number of alarms that are In Alarm and Acknowledged 

The number of alarms that are Normal and 
Unacknowledged 

The number of alarm faults 

For all of the possible priorities and alarms states that can be shown in the 
Alarm and Event objects, see FactoryTalk Alarms and Events Help: 

1. In Windows, click Start > All Programs > Rockwell Software > 
FactoryTalk Alarms and Events > User Documentation > FactoryTalk
Alarms and Events Help.

Monitor alarms and events 
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2. In the section "Monitor alarms during runtime," see these topics:

a. Alarm and Event Summary > About the columns in the Alarm and
Event Summary

b. Alarm Status Explorer > About the columns in the Alarm Status
Explorer

c. Alarm and Event Log Viewer > About the columns in the Alarm and
Event Log Viewer

You can use FactoryTalk Security to control which users can acknowledge, 
enable, disable, reset, suppress, or shelve alarms at runtime in an application 
(or in an area). 

To do this, in FactoryTalk View Studio or FactoryTalk Administration Console, 
right-click the application (or area) where the alarms are located and then 
click Security. For details, see the FactoryTalk Security System Configuration 
Guide. In Windows, click Start > Rockwell Software > FactoryTalk Tools > 
FactoryTalk Security System Configuration Guide. 

When you acknowledge an alarm it does not correct the condition causing the 
alarm, but it indicates that an operator is aware of the alarm. 

Tip: The Digital Alarm Properties, Level Alarm Properties, and Deviation Alarm Properties dialog 
boxes each contain a Control Tags tab that allows you to acknowledge alarms by using tags in the 
controller (remote acknowledgment). 
• At runtime, the alarm state in graphic objects changes to Acknowledged when the remote 

acknowledge tag value is changed to positive. 
• The alarm import and export functions support remote acknowledgment. 
See FactoryTalk Alarms and Events Help for more information on using the Control Tags tab. 

A single tag might have several alarm conditions In Alarm. Each alarm 
condition must be acknowledged separately. For example, a tag that monitors 
a temperature might trigger HI and HIHI alarm conditions by the time it is 
acknowledged. The alarm could also go In Alarm and Out of Alarm several 
times before it is acknowledged. 

Previous occurrences of an alarm that have gone Out of Alarm and then back 
In Alarm cannot be acknowledged. These older occurrences are referred to as 
out of scope and are displayed in the alarm list with a different icon. When the 
most recent occurrence of an alarm is acknowledged, previous occurrences 
are removed from the alarm list. 

In the Alarm and Event Summary event list, do one of the following: 

• Select the alarms you want to acknowledge, and then click the

Acknowledge selected alarm button .

Security for alarms and 
events 

Acknowledge an alarm 

Acknowledge the selected 
alarm 
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• Select the alarms you want to acknowledge, right-click the selected
alarms, and then click Ack.

1. In the Alarm and Event Summary event list, do one of the following:

• Select the alarms you want to acknowledge, and then click

Acknowledge selected alarm with comment .
• Select the alarms you want to acknowledge, right-click the selected

alarms, and then click Ack Comment.

2. In the Acknowledge Alarm with Comment dialog box, type a
comment, and then click Acknowledge. If historical logging is set up,

Acknowledge the selected 
alarm and enter a comment 
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the comment is displayed in the Alarm and Event Log as part of the 
Tracking event that is generated from the Acknowledge command. 

Tip: You can view the last comment that was entered for an operation (for example, ack, 
disable, suppress) in the Alarm Details dialog box. To view a comment associated with an 
alarm state, select an alarm and then click the Show details for the selected alarm button on 
the toolbar. In the Alarm Details dialog box, expand an alarm state (Disabled, Suppressed, 
Acknowledged, and so on) to view the comment associated with that state. 

In the Alarm and Event Summary toolbar, do one of the following: 

• Click Ack page of alarms . All alarms currently visible in the event 
list are acknowledged.

• Right-click one of the alarms and then click Ack Page.

In the Alarm and Event Summary toolbar, do one of the following: 

• Click Acknowledge all alarms contained in list . All alarms in the
event list are acknowledged, even if they are not all visible. However, if
the list is filtered, alarms that are filtered out are not acknowledged.

Acknowledge all of the 
alarms displayed on the 
page 

Acknowledge all of the 
alarms in the event list 
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• Right-click one of the alarms, and then click Ack All.

When an alarm is disabled the operator is not notified when the alarm 
condition occurs and the alarm is removed from the Alarm and Event Banner. 

• An alarm that is disabled is effectively turned off in the controller.
• The alarm condition is no longer monitored and notifications are not

generated by the controller.
• Disabled alarms do not sound the alarm bell in the Alarm and Event

Banner.
• Unacknowledged disabled alarms are displayed in the Alarm and Event

Summary.

Unlike a silenced alarm, a disabled alarm does not trigger the alarm bell in the 
Alarm and Event Banner if the alarm condition occurs again after the alarm 
was disabled. 

Tip: Disable alarms that are related to equipment that is being shut down or serviced. 

To enable alarms, use the Alarm Status Explorer. See Enable selected alarms 
on page 92. 

When an alarm is enabled, the operator is notified when the alarm condition 
occurs. Enabled alarms sound the alarm bell, and continue appearing as new 
events in the Alarm and Event Summary, unless they are suppressed. 

IMPORTANT You can use FactoryTalk Security to control who can disable or suppress alarms. If a user 
attempts to perform an operation for which they do not have the required security rights, 
the operation will fail and a message will be displayed stating that the user has 
insufficient rights to perform the operation. To add another level of security, the Alarm 
and Event Summary can be configured not to show the toolbar buttons, which also hides 
those operations on the context (shortcut) menu. 

1. In the Alarm and Event Summary event list, do one of the following:

Disable or enable an alarm 

Disable selected alarms 
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• Select the alarms you want to disable, and then on the toolbar, click
the Disable selected alarm button.

• Select the alarms you want to disable, right-click the selected
alarms, and then click Disable.

2. In the Disable Alarm dialog box, type a comment (for example, to
explain why the alarm is disabled) and then click Disable.

This comment is stored with the alarm and is logged to the Comment 
field in the Alarm and Event Log, which you can view using the Alarm 
and Event Log Viewer. 

Tip: Any alarms you disable stay in that state until you enable them again. You must use the 
Alarm Status Explorer to enable alarms. 

1. In the Alarm and Event Summary window, do one of the following:

• If it is visible on the toolbar, click the Display the Alarm Status 

Explorer button .

Enable selected alarms 
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• If the toolbar button is not visible, right-click an alarm in the Alarm
and Event Summary event list, and then click Alarm Status.

2. In the Alarm Status Explorer window, select the alarms you want to

enable and then click the Enable selected alarm button .

Any alarms you enable stay in that state until you disable them again. 
For details about the other features of the Alarm Status Explorer, click 

Help in the dialog box. 

You can suppress an alarm that is not needed temporarily, for example, 
suppress an alarm that is caused by another alarm that you are already 
addressing. You can suppress or unsuppress up to 2000 alarms at one time. 

• A suppressed alarm is not displayed in the Alarm and Event Banner.

If an alarm is displayed in the Alarm and Event Banner and then
suppressed, it is removed from the alarm list.

• An unacknowledged suppressed alarm is displayed in the Alarm and
Event Summary.

If an alarm is displayed in the Alarm and Event Summary and then
suppressed, it is only removed from the alarm list when it is
acknowledged.

Suppress or unsuppress an 
alarm 
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• A suppressed alarm continues to be logged in the alarm history log,
which you can view using the Alarm and Event Log Viewer. See Set up
historical alarm and event logging on page 101 for more information.

• A suppressed alarm also continues to set the appropriate InAlarm
parameters of an alarm instruction in the controller.

Disable an alarm instead of suppressing it if you want to completely turn off 
the alarm detection logic for the alarm source and prevent the alarm from 
being detected. See Disable selected alarms on page 91. 

1. In the Alarm and Event Summary event list, do one of the following:

• Select the alarms you want to suppress and then click the Suppress 

selected alarm button .
• Select the alarms you want to suppress, right-click the selected

alarms, and then click Suppress.

2. In the Suppress Alarm window, optionally type a comment, and then
click Suppress.

A comment is stored with the alarm and is logged to the Comment 
field in the Alarm and Event Log, which you can view using the Alarm 
and Event Log Viewer. 

Suppress an alarm 

Unsuppress an alarm 
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Unsuppress an alarm that was previously suppressed if it now needs to be 
monitored again. For example, an operator might have suppressed an alarm 
because the alarm was caused by another alarm that an operator was already 
attending to. 

An unacknowledged suppressed alarm is displayed in the Alarm and Event 
Summary. 

To unsuppress an alarm, follow these steps: 

1. In the Alarm and Event Summary, right-click an alarm and then click
Alarm Status.

2. In the Alarm Status Explorer window, select the alarm or alarms you
want to unsuppress, and then on the toolbar click the Unsuppress 

selected alarm  button.

Tip: You can filter alarm sources to make it easier to find the alarm you want. In the Name box, 
type all or part of an alarm name, or select an alarm status from the list. You can use the * and 
? wildcard characters in the filter. For details about filtering alarm sources, see FactoryTalk 
Help. In Windows, click Start > All Programs > Rockwell Software > FactoryTalk Tools > 
FactoryTalk Help. 
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3. In the Unsuppress Alarm dialog box, optionally type a comment on
why the alarm is unsuppressed, and then click Unsuppress.

This comment is stored with the alarm and is logged to the Comment 
field in the Alarm and Event Log, which you can view using the Alarm 
and Event Log Viewer if historical logging has been configured. 
For details about the other features of the Alarm Status Explorer, click 

the Help button . 

Shelving an alarm temporarily suppresses it. When shelving, the operator 
specifies a duration for the alarm to remain shelved. The alarm is 
automatically unshelved when the duration runs out. 

Tip: Shelving is supported in the Logix Designer application version 21 or later. 

A shelved alarm is displayed in the Alarm and Event Summary or Alarm 
Status Explorer. However, a shelved alarm is not displayed in the Alarm and 
Event Banner. 

Disable an alarm, instead of shelving it, if you want to completely turn off the 
alarm detection logic for the alarm source, and prevent the alarm from being 
detected. See Disable selected alarms on page 91 for more information. 

1. In the Alarm and Event Summary event list, do one of the following:

• Select the alarm you want to shelve and click the Shelve selected 

alarm button  on the toolbar.

Shelve or unshelve an alarm 

Shelve an alarm 
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• Right-click the alarm you want to shelve and select Shelve.

2. The Shelve Alarm dialog box appears.

In the dialog box, enter the following information if desired: 

Field Description 
Alarm name Shows the name of the selected alarm. 

If multiple alarms are selected, this shows as Multiple (x alarms selected) 
where x is the total count of selected alarms. 

Shelve duration Specifies the period of time the alarm should be shelved. Once the shelve 
duration expires, the alarm is unshelved. The value must be a whole number. 
• Default: 1 
• Minimum: 1
• Maximum: 2147483647 

Comment (optional) Specifies the reason for shelving the alarm. 
The default value is empty. The maximum length is 512 characters. 
This comment is stored with the alarm and is logged to the UserComment 
field in the alarm database, which you can view using the Alarm and Event 
Log Viewer. 

3. When complete, click Shelve.

When you reshelve alarms, the conditions vary depending on the type of 
alarms: 
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Alarm type Alarm condition 
A digital alarm The alarm is shelved with the new specified duration. The alarm unshelve time is also 

updated accordingly. 
An analog alarm If one or more of the alarm conditions you reshelve were previously shelved, the alarm 

condition is shelved with the new specified duration and the alarm unshelve time is also 
updated accordingly. 
If none of the alarm conditions you reshelve were previously shelved, the alarm condition 
is shelved targeting to the old unshelve time. 

If alarms that were previously shelved need to be monitored again, you can 
unshelve the specified alarms in the Alarm Status Explorer. 

1. In the Alarm and Event Summary window, right-click an alarm and
then click Alarm Status.

2. In the Alarm Status Explorer, select the alarm or alarms you want to

unshelve, and then click the Unshelve selected alarm button on 
the toolbar.

Unshelve an alarm 
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3. In the Unshelve Alarm dialog box, optionally enter a comment about
why the alarm is unshelved, and then click Unshelve.

The comment is stored with the alarm and is logged to the Comment 
field in the Alarm and Event Log, which you can view using the Alarm 
and Event Log Viewer if historical logging has been configured. 

You can also unshelve all shelved alarms in the Alarm and Event Summary: 

1. In the Alarm and Event Summary event list, do one of the following:

2. On the toolbar, click the Unshelve all alarms button . 

• Right-click an alarm in the list, and then click Unshelve All.



Chapter 9 Monitor and interact with alarms at runtime 

100 Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 

3. The Unshelve All Alarms dialog box appears. Optionally enter a
comment on why the alarms are unshelved and then click Unshelve 
All.
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Chapter 10 

Set up historical alarm and event logging 

Use the FactoryTalk Alarm and Event Log Viewer to view alarms and events 
that have been logged to a Microsoft SQL Server database that is configured to 
store historical alarm and event data. 

Tip: If you do not have a Microsoft SQL Server database installed, we recommend that you install it using 
the batch file available in the FactoryTalk View installation package in the FTView\Redist folder. For 
installation instructions, see Install Microsoft SQL Server 2014 SP3 Express on page 165. 
If you already have Microsoft SQL Server installed, you may need to change the configuration options to 
log alarm and event messages. For configuration instructions, see Use an existing Microsoft SQL Server 
database on page 169. 

Use the Alarm and Event Log Viewer to display entries corresponding to all 
event types or to filter the events you want to view. Alarms and events 
generated during runtime can be logged to a Microsoft SQL Server database. 

IMPORTANT Simple Events are not currently supported. A simple event describes a simple occurrence 
in the system, such as failure to access a computer or device. Condition-related events--
those that relate to changes in alarm state, and tracking-related events--those that 
monitor audited changes to the system, are supported. 

To set up historical alarm and event logging, here is an overview of the steps 
to follow. Each step is explained in detail in this chapter. 

• Confirm that the Microsoft SQL Server software is installed.
• Add a database definition to your FactoryTalk system.
• Associate a database definition with an alarm and event server.
• Add an Alarm and Event Log Viewer object to a graphic display.
• Run the FactoryTalk View Site Edition Client software and then

monitor the graphic display.

• If you do not already have Microsoft SQL Server software installed, you
can install it from the FTView\Redist folder in the FactoryTalk View
installation package. For installation instructions, see Install SQL
Server 2014 SP3 Express on page 165.

• Define alarms as described in Define device-based alarms in Logix
5000 controllers on page 29 and Add a tag-based alarm server for Logix
5000, PLC-5, SLC 500, or third-party controllers on page 51.

• Add the appropriate device server as described in Add a device server
for Logix 5000, PLC-5, or SLC 500 controllers on page 39.

• Set up graphic display objects as described in Set up graphic displays
on page 59.

• FactoryTalk Linx software
• FactoryTalk View Studio software
• FactoryTalk View SE Client software
• Microsoft SQL Server software

Before you begin 

What you need 
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Follow these steps to set up historical logging: 

• Plan your system
• Confirm that the Microsoft SQL Server software is installed

Tip: Microsoft SQL Server 2014 SP3 Express is available from the FactoryTalk View installation 
package. 

• Run FactoryTalk View Studio
• Add a database definition to your FactoryTalk system
• Associate the database definition with an alarm server
• Add an Alarm and Event Log Viewer object to a graphic display
• Run FactoryTalk View SE Client software and then monitor the

graphic display
• Monitor and interact with alarms during runtime

To log historical alarms and events, you can either install Microsoft SQL 
Server or you can use an existing SQL Server database already installed on 
your network. If you are using an existing SQL Server database you need to 
set up your database for alarm and event logging. See Summary of steps on 
page 169. 

FactoryTalk Alarms and Events can log historical data to any of the supported 
SQL Server databases. For more information, see Supported SQL Server 
databases on page 169. 

Tip: SQL Server 2014 SP3 Express software is available in the the FactoryTalk View installation package 
in the FTView\Redist folder. 
To install SQL Server 2014 SP3 Express, see Install SQL Server 2014 SP3 Express on page 165. 
If you are using an existing SQL Server database, see Use an existing SQL Server database on page 169. 

Create a database definition that specifies the connection information for the 
database and creates the required database objects. 

Step 1. Open an existing application in FactoryTalk View Studio 
1. Open FactoryTalk View Studio.
2. In the Application Type Selection window, select View Site Edition 

(Local Station) and then click Continue.
3. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab, and then select the My Local Site application

Follow these steps 

Confirm that the SQL Server 
software is installed 

Add a database definition to 
your FactoryTalk system 
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that you created in Add a device server for Logix 5000, PLC-5, or SLC 
500 controllers on page 39. 

Step 2. Create a new database connection 
1. In the Explorer window, expand the folders System > Connections

and then right-click the Databases folder. Click Add Database 
Connection.

2. In the Database Connection Properties dialog box, configure
properties for the new database definition. Select FactoryTalk Alarms
& Events History Database in the Database type list.

In this example, we used FTAE_History for the definition name and
database name. The authentication includes Windows authentication
and SQL Server authentication. We used SQL Server authentication
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with FTAE_Historian as the database user name, and password as the 
password. 

Tip: To improve efficiency when writing to the database, information is sent to a cache file 
located on the computer hosting the alarm server before writing to the database. 

3. Click the Alarms Advanced settings tab. The system will attempt to
create the database, the user account, and the tables that are necessary
to store the alarm and event information. If the database or user does
not already exist in SQL Server, you are prompted to create them. Click
Yes.

4. Configure the settings for the Alarm and Event History Database.
5. If the connection to the database is lost, alarm and event information

will continue to be cached to files. After the connection is restored, the
cached information will be sent to the database.

To limit how much information is cached, reduce the amount of days
or % of available disk space for database buffering. When the limit is
reached, the oldest information is overwritten.
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6. When you finish, click OK. If you are prompted to create the database,
click Yes. The database definition is added to the Databases folder and
is ready for use.

To set up a FactoryTalk Linx device server (device-based server) or a 
FactoryTalk Tag Alarm and Event Server (tag-based server) to log historical 
alarm and event data to a database, you must associate a database definition 
with the alarm server. 

If no alarm history database is associated with an alarm server, the alarm 
server does not log any historical data. You can associate different alarm 
servers with different alarm history databases, or you can have all alarm 
servers log their data to the same database. 

For details about setting up alarm servers, see Add a device server for Logix 
5000, PLC-5, or SLC 500 controllers on page 39 or Add a tag-based alarm 
server for Logix 5000, PLC-5, SLC 500, or third-party controllers on page 51. 

Step 1. Open an existing application in FactoryTalk View Studio 
1. Open FactoryTalk View Studio.
2. In the Application Type Selection window, select View Site Edition 

(Local Station) and then click Continue.
3. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab, and then select the My Local Site application
that you created in Add a device server for Logix 5000, PLC-5, or SLC
500 controllers on page 39.

Step 2. Configure the alarm server 
1. In the Explorer window, expand the application tree until each alarm

server is visible.

Associate a database 
definition with an alarm 
server 
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2. Right-click the alarm server named FTAE Server that you created in
Add a device server for Logix 5000, PLC-5, or SLC 500 controllers on
page 39. Click Properties. 

3. For a FactoryTalk Linx Device Server, do the following and then click
OK:

• In the FactoryTalk Linx Server Properties dialog box, click the
Alarms and Events tab.

• Under Alarm and Event History, select the Enable history check
box.

• In the Database definition list, select a definition (for this example,
we use FTAE_History).
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4. For a Tag Alarm and Event Server, do the following and then click OK:

• In the FTAE Server Properties dialog box, click the Priorities and 
History tab.

• Under Alarm and Event History, select the Enable history check
box.

• In the Database Definition list, select a definition. In this example,
we use FTAE_History.

Use the Alarm and Event Log Viewer to view alarm and event information 
previously logged in a Microsoft SQL database configured to store historical 
data. 

Step 1. Open an existing application in FactoryTalk View Studio 
1. Open FactoryTalk View Studio.
2. In the Application Type Selection window, select View Site Edition 

(Local Station) and then click Continue.
3. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab, and select the My Local Site application that you
created in Add a device server for Logix 5000, PLC-5, or SLC 500
controllers on page 39.

Create an Alarm and Event 
Log Viewer display 
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Step 2. Create a new graphic display 
1. In the Explorer window, expand the Graphics folder, right-click

Displays, and then click New.

A blank display appears in the workspace. 

2. If necessary, resize the graphic display to about the same size as the
one you created for the Alarm and Event Summary.

Step 3. Add an Alarm and Event Log Viewer object to the display 
1. On the Objects menu, point to Alarm and Event and then click Log 

Viewer (or select Alarm and Event Log Viewer in toolbox).
2. Hold the left mouse button down and drag the mouse to create a

rectangle that is the size required for the Alarm and Event Log Viewer
object.
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3. When the object is the correct size, release the left mouse button. The
Alarm and Event Log Viewer object is drawn on the graphic display.

Step 4. Configure the properties of the Alarm and Event Log Viewer 
1. To open the Alarm and Event Log Viewer Properties dialog box,

double-click the Alarm and Event Log Viewer object.

2. On the General tab, select the alarm log whose entries you want to
view. In the previous example, we selected FTAE_History. This is the
SQL database we created in Associate a database definition with an
alarm server on page 105.

3. Click the Columns tab, and then clear the Area check box.
4. On the other tabs, set properties to customize the Log Viewer display,

as desired. For details, click Help.
5. When you are finished, click OK to close the dialog box.

Step 5. Save the graphic display 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the new display and then click

OK.
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In this example, we use Alarm and Event Log Viewer for the name of 
the graphic display. 

3. Close the graphic display.

In this section, we add a button to open the Alarm and Event Log Viewer 
display in the same FactoryTalk View Client window as the Alarm and Event 
Banner display. 

Step 1. Create a new graphic display 
1. In the Explorer window, expand the Graphics folder, right-click

Displays, and then click New.

2. If necessary, resize the graphic display to about the same size as the
one you created for the Alarm and Event Summary.

Step 2. Add a button to the graphic display 
1. On the Objects menu, point to Push Button, and then click Button (or

select Button in the toolbox).
2. Hold the left mouse button down and drag the mouse to create a

rectangle the correct size for the button and then release the mouse
button.

Create a button to open the 
Alarm and Event Log Viewer 
display 
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3. In the Button Properties dialog box, click the Action tab.

Step 3. Configure the button commands 
1. Click the Browse button (...) to the right of the Press action field to

open the Command Wizard.

2. In the Command Categories pane on the left, expand Graphics > 
Graphic Displays > Navigation.

3. In the list of commands on the right, click Display, and then click Next.
4. In the File box, click the browse button to select the name of the

graphic display that is to open when the button is clicked.
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In this example, we want the button to start the Alarm and Event Log 
Viewer, so we select Alarm and Event Log Viewer. 

5. To close the Command Wizard, click Finish. In the Button Properties
dialog box, the command Display "Alarm and Event Viewer" appears
in the Press action box.

6. Click the Up Appearance tab.
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7. In the Caption box, type Run the Alarm and Event Log Viewer. Press
the Enter key after the word Alarm so that the text wraps to the next
line. This is the text that will appear on the button.

8. Click OK to save the button configuration. The button is drawn on the
graphic display.

Step 4. Configure the properties of the graphic display 
1. On the main menu bar Edit menu, click Display Settings.

2. In the Display Settings dialog box, make the following changes on the
Properties tab:

• Clear the Title Bar check box.
• Select the Size to Main Window at Runtime check box.
• Select the Allow Display to be Resized check box.
• Under When Resized, select Scale option if it is not already

selected.

Click OK when finished. 
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Step 5. Save the graphic display 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the new graphic display, and

then click OK.

In this example, we use Menu Bar for the name of the graphic display.

This section shows you how to modify the startup macro you created in Set up 
graphic displays on page 59. This example also shows you how to add 
commands to the startup macro that will open the button display you just 
created and dock it to the top of the client window. 

Step 1. Edit the startup macro 
1. In FactoryTalk View Studio, in the Explorer window, double-click the

Start Alarm and Event Banner macro.

The macro editor opens, showing the Banner display command
Display "Alarm and Event Banner" /DB.

2. To open the Command Wizard, double-click anywhere in the body of
the macro editor.

3. In the list of commands on the right, select Display and then click
Next.

Create a startup macro for 
the Menu Bar display 
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4. In the File list, click Menu Bar.

5. Select the Window Position check box. In the list of window positions,
click Docked to the Top.

6. To save the configuration and display it in the macro editor, click
Finish.

Step 2.  Save the startup macro in the application 
1. On the File menu, click Save.
2. Close the macro editor.

Use the Alarm and Event Log Viewer--embedded in a FactoryTalk View 
graphic display--to view, sort, filter, and export historical alarm information 
stored in Alarm and Event Logs. 

With the Alarm and Event Log Viewer, you can: 

• Display alarm and event information that has been logged by the
FactoryTalk Alarm and Event Historian.

• Define filters to determine which logged alarms and events will be
displayed.

• Sort the alarms and events that will be displayed.

View historical alarm data in 
a FactoryTalk View SE Client 
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You can open the FactoryTalk View Site Edition Client in these ways: 

• From the Windows Start menu. See Monitor and interact with alarms
at runtime on page 83.

• From within FactoryTalk View Studio, which is covered in this section.
• By double-clicking a FactoryTalk View SE Client configuration file

(*.cli).

1. If FactoryTalk View Studio is not still open, click Start > All Programs > 
Rockwell Software > FactoryTalk View Enterprise> FactoryTalk View 
Studio.

2. In the Application Type Selection window, select View Site Edition 
(Local Station) and then click Continue.

3. In the New/Open Site Edition (Local Station) Application dialog box,
click Cancel.

4. In FactoryTalk View Studio, on the toolbar, click the Launch SE Client
button.

5. In the FactoryTalk View SE Client Wizard, select Run an existing 
FactoryTalk View SE Client configuration file, and then select Alarms
and Events Demo.cli. Click OK.

Run the application 

Start the FactoryTalk View 
SE Client from within 
FactoryTalk View Studio 
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The FactoryTalk View SE Client opens after a few moments. The 
button appears at the top of the window and the Alarm and Event 
Banner appears at the bottom. 

6. Click the Run Alarm and Event Log Viewer button to make the Log
Viewer appear in the middle of the client window:
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7. Click the Run Alarm and Event Summary button on the Banner
display at the bottom of the window. The Summary display replaces
the Log Viewer.

For details about enabling, disabling, suppressing, unsuppressing, shelving, 
unshelving, and acknowledging alarms, see Monitor and interact with alarms 
at runtime on page 83. 
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Chapter 11 

Configure redundancy for alarms and events 

This chapter describes how to configure FactoryTalk Alarms and Events 
device-based and tag-based alarm server redundancy.  

Server redundancy is typically used to maximize system availability in case of: 

• Computer hardware failure.
• Software failure on one server computer.
• Power failure on one server computer.

Redundancy requirements are unique to each application. The ideal 
redundant solution involves having at least two instances of everything--
hardware, software, and networks. In practice, this is seldom necessary. 
Redundant FactoryTalk server components duplicate server information on a 
secondary computer that is used if a primary server computer fails. 

FactoryTalk server redundancy can be configured for: 

• FactoryTalk Alarms and Events servers
• Data servers (FactoryTalk Linx or OPC data server)
• FactoryTalk Site Edition HMI servers

IMPORTANT FactoryTalk Alarms and Events server redundancy and data server redundancy 
are only supported in network station applications and network distributed 
applications. 
FactoryTalk HMI server redundancy is only supported in network distributed 
applications. 

For more information on planning and implementing a FactoryTalk 
distributed network application, see Reference for building a distributed 
system on page 189. 

It is good practice when developing a FactoryTalk Alarms and Events 
application to develop and test with all alarm servers configured without 
redundancy. This approach effectively reduces the size and complexity of the 
application during the development and test phases. 

Adding alarm server redundancy at the end of development to a properly 
planned network station application or network distributed application will 
not require any changes in graphic displays that are already developed and 
working properly. 

Existing alarm servers and tag data servers can be configured to support 
redundancy if the distributed system supporting your FactoryTalk application 
has been adequately planned and prepared beforehand. 

To implement redundant servers, the procedure depends on whether you are 
using a device-based alarm server or a tag-based alarm server. 

FactoryTalk server 
redundancy 

Develop and test your 
application without 
redundancy 

Before you begin 
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• Plan and implement your FactoryTalk distributed system, taking into
consideration which components require redundancy, the network
layout of the components in the system, the CPU processing load that
is expected for each component, and the software required to be
installed on each component.

• Configure alarm servers and tag data servers as required. Initially,
configure these servers without redundancy. Verify that all of the
configured tags and alarms are working properly.

• Be sure all graphic displays are working properly on the FactoryTalk
application with alarm servers configured without redundancy.

• For each redundant alarm server, determine if it will use favor primary
or favor current switchover behavior.

Favor current. When a redundant switchover occurs, the secondary
server remains active in the application even after the primary server is
recovered and available once again. This is the default behavior, set in
the Server Properties dialog box Redundancy tab under Switchover 
options by selecting Continue using the secondary server even when 
the primary server becomes available again. When it is selected you
can perform manual switchovers from primary to secondary and back
again. This can be useful for testing redundant applications. You can
change this selection at any time.
Favor primary. After a redundant switchover has occurred, and the
primary server is recovered and available again, control passes back to
the primary server. This is set in the Server Properties dialog box
Redundancy tab under Switchover options by selecting Switch over to 
primary server when it becomes available again.
You can change the redundant server configuration from favor current
to favor primary any time that both servers are running and connected
to the network station application or network distributed application.

If you are using device-based alarm servers: 

• FactoryTalk Linx and FactoryTalk Alarms and Events installed and
running on the primary server computer, configured and working as a
non-redundant component.

• FactoryTalk Linx and FactoryTalk Alarms and Events installed and
running on the secondary server computer.

• FactoryTalk View Studio or FactoryTalk Administration Console
running on a development station or other component connected in
the FactoryTalk application.

If you are using server tag-based alarm servers: 

• FactoryTalk Linx or OPC Data Server installed, configured, and 
running on a separate component configured in the FactoryTalk
application, or configured for redundancy and running on the primary
and secondary server computers as a redundant pair.

What you need 
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• FactoryTalk Alarms and Events installed and running on the primary
server computer, configured and working as a non-redundant
component.

• FactoryTalk Alarms and Events installed and running on the secondary
server computer.

• FactoryTalk View Studio or FactoryTalk Administration Console
running on a development station or other component configured in
the FactoryTalk application.

Follow these steps for device-based alarm servers: 

• Add a device-based alarm server
• Start FactoryTalk View Studio and open the Site Edition network

application
• Select the device alarm server
• Configure the server properties
• Open the Communication Setup editor
• Configure the secondary path to the Logix 5000 controller
• Check the server status

Follow these steps for tag-based alarm servers: 

• Add a tag-based alarm server
• Start FactoryTalk View Studio and open the Site Edition network

application
• Select the tag alarm server
• Configure the tag alarm server properties
• Check the server status

In this section, you will upgrade a configured Rockwell Automation device-
based alarm server (FactoryTalk Linx) to support redundancy using a 
secondary computer already configured in the FactoryTalk network 
distributed application. 

Step 1. Open the application in FactoryTalk View Studio 
This example shows how to open an existing network distributed application 
in FactoryTalk View Studio. 

1. To run FactoryTalk View Studio, in Windows, click Start > All 
Programs > Rockwell Software > FactoryTalk View > FactoryTalk
View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Network Distributed) and then click Continue.

3. In the New/Open Site Edition (Network Distributed) Application
dialog box with the Existing tab selected, under the heading

Follow these steps 

Upgrade an existing device-
based alarm server 
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Application Name, select the name of the existing application. In this 
example, we name the application My Network App. 

4. Click Open.

Step 2. Select the device alarm server 
In the Explorer window, open the application My Network App and 
find the device alarm server FTAE Server. 

Step 3. Configure the alarm server properties 
1. In the Explorer window, right-click the alarm server FTAE Server and

then select Properties.
2. In the FactoryTalk Linx Server Properties dialog box, click the

Redundancy tab. Select the Provide redundancy using a secondary
server check box.

3. In the Redundancy tab, click Browse.
Tip: If your distributed network application has been planned and implemented beforehand as 
recommended, then the secondary server computer name will be listed in the Select Computer 
dialog box. 

4. Select the name of the secondary server computer in the Select
Computer dialog box and then click OK.

5. In the Redundancy tab, the switchover option Continue using the 
secondary server even when the primary server becomes available 
again is selected by default. This allows you to use manual switchover
to test the redundant pair. You can change the selection when testing
is complete. If you select Switch over to primary server when it 
becomes available again manual switchover is not available.
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Step 4. Open the Communication Setup editor 
1. In the Explorer window, click the FactoryTalk Linx server FTAE 

Server, and then double-click Communication Setup.
2. Before the Communication Setup dialog box appears, a FactoryTalk

Linx information dialog box appears. To save the changes, click OK.
Tip: The secondary controller is normally the same device as the primary controller but a 
different path may be used on the Primary tab. For instance, the secondary path may pass 
through an alternate bridge device in order to provide redundancy at the communications level. 

3. To set the path to the secondary controller, click the Apply button.
4. To save the shortcut configuration and close the Communication 

Setup dialog box, click OK.

In this section, you will upgrade a configured Rockwell Automation tag-based 
alarm server to support redundancy using a secondary computer configured 
in the FactoryTalk network distributed application. 

Step 1. Open the application in FactoryTalk View Studio 
This example shows how to open an existing network distributed 
application in FactoryTalk View Studio. 

1. To start FactoryTalk View Studio, in Windows, click Start > All 
Programs > Rockwell Software > FactoryTalk View > FactoryTalk
View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Network Distributed) and then click Continue.

3. In the New/Open Site Edition (Network Distributed) Application
dialog box with the Existing tab selected, under the heading
Application Name, select the name of the existing application. In this
example, we name the application My Network App.

4. Click Open.

Step 2. Select the tag alarm server 
In the Explorer window, open the application My Network App and 
find the tag-based alarm server, for example, TagAE. 

Step 3. Configure the alarm server properties 
1. In the Explorer window, right-click the alarm server TagAE and then

select Properties.
2. In the Tag Alarm and Event Server Properties dialog box, click the

General tab. Select the Load when operating system initializes startup
type option.

Upgrade an existing tag-
based alarm server 
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IMPORTANT The configuration options on the Redundancy tab will be disabled if the Load 
when operation system initialized option is not selected on the General tab. 
This is because redundant servers need to be running and available in order to 
exchange redundant information in preparation for an unexpected switchover, 
even when the HMI application is not actually running. 

3. In the Tag Alarm and Event Server Properties dialog box, click the
Redundancy tab.

4. Select the Provide redundancy using a secondary server check box.
5. Select the secondary server computer from the computer list and then

click OK.
Tip: If your distributed network application has been planned and implemented beforehand as 
recommended, then the secondary server computer name will be listed in the Select Computer 
dialog box. 

6. In the Tag Alarm and Event Server Properties dialog box, the
switchover option Continue using the secondary server even when the 
primary server becomes available again is selected by default. This
allows you to use manual switchover to test the redundant pair. You
can change the selection when testing is complete. If you select Switch 
over to primary server when it becomes available again manual
switchover is not available.

Follow this example anytime you change the configuration properties and 
settings of an alarm server. 

After changing the alarm server configuration you need to reboot the server 
computer. For a network distributed application or network station 
application, the recommended start up sequence is: 

1. FactoryTalk Directory server
2. Primary server computers
3. Secondary server computers
4. Operator workstations

This example demonstrates how to check the status of a redundant alarm 
server in FactoryTalk View Studio using the device alarm server FTAE Server 
created in Add a device server for Logix 5000, PLC-5, or SLC 500 controllers on 
page 39. 

Step 1. Open the application in FactoryTalk View Studio 
1. To start FactoryTalk View Studio, in Windows, click Start > All 

Programs > Rockwell Software > FactoryTalk View > FactoryTalk
View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Network Distributed), and then click Continue.

3. In the New/Open Site Edition (Network Distributed) Application
dialog box, on the Existing tab, select the name of the existing
application. In this example, we named the application My Network
App.

4. Click Open.

Check the status of an alarm 
server 
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Step 2. Select the device alarm server 
In the Explorer window, open the application My Network App and 
find the device alarm server, for example, FTAE Server. 

Step 3. Check server status 
1. In the Explorer window, right-click the alarm server FTAE Server, and

then click Server Status.
Tip: To test your redundant server configuration, trigger a manual switchover by clicking the 
Switchover button. The Switchover button is enabled if the server is configured for 
redundancy, the Switchover options selection is Continue using the secondary server, 
even when the primary becomes available again (default), and both the primary and 
secondary servers are currently available. 

2. To close the Server Status dialog box without making any changes,
click Cancel.
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Appendix A 

Get started with language switching 

You can use language switching to display text strings that you define when 
you create an application, in up to 40 different languages. At runtime, a 
FactoryTalk View SE Client can switch between any of the languages the 
application supports. In a network distributed application or network station 
application, multiple clients can run in different languages at the same time. 

For more information on supported languages, see Language identifiers for 
language switching on page 191. For additional information about configuring 
language switching configuration in FactoryTalk View Studio, see "Setting up 
Language Switching" in the FactoryTalk View Studio Site Edition Help. 

IMPORTANT Time and date formats do not switch. Alarm and Event objects in FactoryTalk View always 
display the date and time format of the operating system. The rest of a FactoryTalk View 
application shows the format for the language FactoryTalk View is displaying. 
Dialog boxes that are part of the graphical user interface of FactoryTalk Alarms and 
Events but not user configurable—for example, the Acknowledge with Comment dialog 
box—do not switch languages. They are displayed in the language of the operating 
system. 
Historical alarm and event messages do not switch languages. They are displayed in the 
language in which they were logged. 

To implement language switching, the procedure depends on whether you are 
using device-based alarm monitoring or tag-based alarm monitoring. If you 
are not sure what type of alarm monitoring to use, see Plan your system on 
page 25. 

If you are using device-based alarm monitoring 
• Review Define device-based alarms in Logix 5000 controllers on page

29.
• Verify that you have installed and activated the software listed in What

you need on page 30.
• Verify that the Logix 5000 firmware has been updated to revision 16 or

later (excluding 21 to 23).

If you are using tag-based alarm monitoring 
• Review Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500,

or third-party controllers on page 51.

Before you begin 
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• If your alarms and events system uses a data server, review Add an
OPC Data Server for third-party controllers on page 47.

If you are using device-based alarms 
• The Logix Designer application (or RSLogix 5000 software version 16

or later)
• ControlFLASH
• RSLinx Classic
• FactoryTalk Linx
• FactoryTalk View Studio
• FactoryTalk View SE Client

If you are using tag-based alarms 
• PLC-5, SLC 500, third-party, or Logix 5000 controllers that have not

been programmed with alarm instructions included in the Logix
Designer application (or RSLogix 5000 software version 16 or later)

• RSLogix 5 or RSLogix 500 software
• FactoryTalk Linx, RSLinx Classic (for bridging from Ethernet to DH+

or DH-485 networks), or a third-party OPC Data Server (for example,
KEPWare server) for communicating with third-party controllers

• FactoryTalk View Studio or FactoryTalk Administration Console
• Microsoft Excel® (for editing exported alarm messages in multiple

languages)

Follow these steps to get started with language switching: 

• Add a device server or add a tag-based alarm server
• Create device-based or tag-based alarm messages
• Add buttons to a graphic display to switch languages
• Add languages to the application
• Edit alarm messages in alternate languages
• Create a display client configuration file
• Test alarm messages at runtime

To create device-based alarm messages in multiple languages you can use the 
import and export features in the Logix Designer application (or RSLogix 
5000 software). At runtime, alarm messages located in Logix 5000 controllers 
can be displayed in the language of the FactoryTalk View application in which 
they are displayed. 

When FactoryTalk Linx connects to the controller, all alarm messages and 
their languages are uploaded from the controller. When a FactoryTalk View 
SE Client runs, the FactoryTalk Alarms and Events objects (Alarm and Event 
Summary, for example) connect to the FactoryTalk Alarms and Events system 
and request alarm messages in the current language. When you switch 

What you need 

Follow these steps 

Create device-based alarm 
messages 
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languages on the client computer, the alarm monitoring system and all of the 
client screens switch to the appropriate language on that specific client. 

IMPORTANT Historical alarm messages are logged in the language currently associated with the Alarm 
and Event Log. The Alarm and Event Log displays messages in the language in which they 
were logged. For example, a message logged in English will be displayed in English, even 
if the language is switched to Italian. 

A system may have thousands of alarm messages that need to be translated. 
To simplify this process, you can export alarm messages to a file, add 
translated messages in multiple languages to the file, and then import the file 
back into your project. Any of the languages you translate the strings into 
must be supported by FactoryTalk View. 

You can enter text strings in multiple languages in two ways. 

1. In RSLogix 5000 software version 16 or earlier, create alarm messages
in one language, and use the RSLogix 5000 Export tool to export the
project's tags, logic comments, descriptions and alarm messages from
RSLogix 5000 to a comma-separated value (*.csv) file or a text (*.txt)
file. The text strings can be translated into other languages and added
to the file. Then use the RSLogix 5000 Import tool to import the
strings back into the project.

2. In RSLogix 5000 software version 17 or later, you select a language for
the project, and then in the Project Documentation Language 
Configuration dialog box you export a localization file that contains
documentation from the project. The documentation included in the
text (*.txt) file includes user-defined logic comments, component
names, and alarm messages. The text strings can be translated into
other languages and added to the file. Use the Project Documentation 
Language Configuration dialog box to import strings back into the
project. See Translating alarm messages using RSLogix 5000 version 17
or later on page 132.

To translate alarm messages using RSLogix 5000 software version 16 or 
earlier, complete the following steps. To translate alarm messages in RSLogix 
5000 software version 17 or later, using the project documentation language 
feature, see Translating alarm messages using RSLogix 5000 version 17 or 
later on page 132. 

Step 1. Export alarm messages from RSLogix 5000 
1. Start RSLogix 5000 (version 16 or earlier) and open the

West_Plant_Controller project you created in Define device-based
alarms in Logix 5000 controllers on page 29. If you have not yet
created the project, do so before continuing.

Translate alarm messages 
using import and export 

Translate alarm messages 
in RSLogix 5000 version 16 
or earlier 
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2. In the RSLogix 5000 window, on the Tools menu, click Export.

3. In the Export dialog box, click Export.

If your RSLogix 5000 project includes a large number of programs, and
you want to translate alarm messages from only one of them, you can
make selections in the Export dialog box to limit the data that is
exported. For details, click Help.

Tip: When translating to or from Unicode character sets (for example, Asian languages), you 
must export and then import the RSLogix 5000 tag database as a .txt file. The .csv format does 
not support Unicode character sets. This limitation does not apply to Tag Alarm and Event 
Servers. 

Step 2. Translate the exported alarm messages 
1. In Windows Explorer, locate the file you exported and then double-

click it to open it in Notepad. You can also edit the file using Microsoft
Excel.

The last line of text in the file is the alarm definition. The first element 
from the left is the instruction type (ALMMSG:) and the language 
string for the alarm message (en-us for English in the United States). 
The alarm message text appears as the fourth element from the left 
(Tank Temperature is High). 

2. Copy the ALMMSG line and paste it at the end of the file.
3. Change en-us to it-it (for Italian in Italy), and then change the alarm

message text to read La temperatura del serbatoio e alta.
4. Paste another copy of the ALMMSG line at the end of the file.
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5. Change en-us to de-de (for German in Germany), and change the
alarm message text to read Hohe Tanktemperatur!.

6. On the File menu, click Save.
Tip: When you import alarm messages, the system verifies the message length and displays a 
warning if the alarm message exceeds the character limit. 

Step 3. Import the translated alarm messages 
1. In the RSLogix 5000 software, on the Tools menu, click Import.
2. In the Import window, select the file you modified and then click

Import.

The import process produces warnings because it overwrites existing 
tags. 
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Step 4. Download the project to the controller 
To update the controller with additional alarm messages in the new 
languages, download the project to the controller. 

Next, either continue setting up tag-based alarm messages, or set up a graphic 
display for language switching. See Add buttons to a graphic display to switch 
languages at runtime on page 139. 

The steps in this procedure apply to RSLogix 5000 software version 17 and 
later, and the Studio 5000 Logix Designer application version 21 and later, 
both referred to in this procedure as the application.  

To translate alarm strings use the project documentation import and export 
feature. Only the information that is necessary for localization is included in 
the exported file. 

Step 1. Export alarm messages 
1. Run the application and open the West_Plant_Controller project you

created in Define device-based alarms in Logix 5000 controllers on
page 29. If you have not created the project, do so before continuing.

2. To open the Project Documentation Language dialog box, click the

Documentation Language Configuration icon  or click
Documentation Languages on the Tools menu.

3. To associate the existing product documentation with a language,
select a language from the Select a language list or click Custom and
then add a custom language. For example, select English (United 
States) from the list and then click OK.

4. After you select a language for the project, the Project Documentation 
Language Configuration dialog box opens. If the dialog box does not

Translate alarm messages 
using RSLogix 5000 version 
17 or later 
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open after a short time, click Documentation Languages on the Tools 
menu. To export a localization file, click Export. 

5. In the Export Project Documentation dialog box, select the languages
to include in the localization file and then click Next. For example,
select German (Germany) and Italian (Italy) if the project
documentation will be translated into German and Italian.

6. To add the configuration information to the localization file, click
Next.

7. Specify the name and location of the exported localization file and
then click Export.

8. Click OK.

Step 2. Translate the exported alarm messages 
1. In Windows Explorer, locate the file you exported. Right-click the file,

point to Open With and then click Microsoft Excel.

The first column contains the instruction type ALMMSG. Column C is 
labeled KEY:en-US [English (United States)] and the alarm message is 
displayed in English. 



Appendix A Get started with language switching 

134 Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 

Column D is labeled de-DE [Deutsch (Deutschland)], and Column E is 
labeled it-IT [italiano (Italia)]. These are the languages you selected for 
the export. 

2. Type Hohe Tanktemperatur! in column D in the same row that shows
Tank Temperature is High.

3. Type La temperatura del serbatoio e alta in column E in the same row
that shows Tank Temperature is High.

4. On the File menu, click Save.

Step 3. Import the translated alarm messages 
1. In the application, on the Tools menu, click Documentation 

Languages.
2. In the Project Documentation Language Configuration dialog box,

click Import.
3. In the Select File dialog box, select the file you modified and then click

Import.
4. Verify the languages you want to import in the Import Project 

Documentation dialog box, and then click Import.
5. Click OK.

Tip: When you import alarm messages, the application verifies the message length and displays 
a warning if the alarm message exceeds the 255 character limit. 

Step 4.   Download the project to the controller 
To update the controller with additional alarm messages in the new 
languages, download the project to the controller. 

Next, either continue with setting up tag-based alarm messages, or set up a 
graphic display for language switching. See Add buttons to a graphic display 
to switch languages at runtime on page 139. 

The alarm messages in a tag-based alarm server also support language 
switching. As with device-based alarms, in FactoryTalk View you can also 
enter text strings in multiple languages in two ways: 

1. The messages in the Alarm and Event Setup editor are saved in the
language you select when opening an application in FactoryTalk View.

2. After creating alarm messages in one language, you can export them
from FactoryTalk View to a Microsoft Excel (*.xls ) or XML file (*.xml ),
add translated versions of the strings to the exported file, and then
import them into FactoryTalk View again.

The maximum length for alarm messages is 255 characters. When you
import alarm messages, anything over 255 characters is truncated.

Create tag-based alarm 
messages 
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Step 1. In FactoryTalk View Studio, choose a language in which to open 
an application 

1. To start FactoryTalk View Studio, in Windows click Start > All 
Programs > Rockwell Software > FactoryTalk View > FactoryTalk
View Studio.

2. In the Application Type Selection window, select View Site Edition 
(Local Station) and then click Continue.

3. In the New/Open Site Edition (Local Station) Application dialog box,
click the Existing tab, select the application you created in Add a device
server for Logix 5000, PLC-5, or SLC 500 controllers on page 39 (we
used My Local Site). 

4. In the Language list, select the language in which you are creating your
application (in this example, English (United States), en-US), and then
click Open.

Step 2. Create a digital alarm 
This section uses the FactoryTalk Tag Alarm and Event Server you created in 
Add a tag-based alarm server for Logix 5000, PLC-5, SLC 500, or third-party 
controllers on page 51. If you have not yet created the server, do so before 
continuing. 

Enter text strings in 
FactoryTalk View Studio 
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1. In the Explorer window, expand the new Tag Server, and then double-
click Alarm and Event Setup.

In the Alarm Setup dialog box, click the Digital tab. 

2. On the toolbar, click the New button . 
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3. In the Digital Alarm Properties dialog box, in the Name box, type
TankTempThreshold.

4. In the Input Tag field, type system\Second. This tag uses the second
count from the computer's internal clock to trigger the alarm. You can
also click the Browse button (...) beside the Input Tag field to select the
system\Second tag and then click OK.

5. In the Digital Alarm Properties dialog box, in the Condition list, select
Input = 0. This triggers the alarm every time the value of the
system\Second tag is 0, which happens every minute.
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6. In the Message field, type Tank Temperature is High, and then click
OK.

7. Close the Alarm and Event Setup editor and save your changes.

1. In FactoryTalk View Studio, on the Tools menu, click Languages.
2. In the Language Configuration dialog box, select the Display 

undefined strings using the default language check box, and then click
Add.

When the Display undefined strings using the default language check 
box is selected, any strings that are not defined in the current language 
are displayed in the default language at runtime. 
When this check box is not selected, any strings that are not defined in 
the current language are displayed as question marks (???) at runtime. 

Add languages to the 
application 



Appendix A Get started with language switching 

Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 139 

3. In the Add Language dialog box, click German (Germany) and then
click OK.

4. In the Language Configuration dialog box, click Add to add the next
language.

5. In the Add Language dialog box, click Italian (Italy) and then click OK.

6. In the Language Configuration dialog box, click OK.

In this section, we add a button to a graphic display which can be used to 
switch among available languages at runtime. 

Step 1. Create a new graphic display 
1. In FactoryTalk View Studio, in the Explorer window, expand the

Graphics folder.

Add buttons to a graphic 
display to switch languages 
at runtime 
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2. Right-click Displays, and then click New.

Step 2. Add buttons to the graphic display 
1. On the Objects menu, select Push Button > Button.
2. In the graphic display, hold down the left mouse button and then drag

the mouse to draw a box for the button.

3. On the Edit menu, click Copy.
4. On the keyboard, press Ctrl-V twice, to paste two more copies of the

button in the graphic display.
5. Drag the copies of the button apart on the display.
6. On the keyboard, press Ctrl-A to select all of the buttons.
7. On the Arrange menu, click Align Top to align the tops of the buttons.
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8. On the Arrange menu, click Space Horizontal to space the buttons
equally apart.

Step 3. Add captions to the buttons 
1. Double-click the first button to edit it.
2. In the Button Properties dialog box, click the Action tab.

3. Click the Browse button to the right of the Release action field. 
The Command Wizard opens.

4. In the Command Categories pane on the left, expand All Commands
and Macros.

5. In the list of commands on the right, click Language, and then click
Next.

6. In the Language ID list, select the name of the language and then click
Finish.
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In this example, we are using English (United States), en-US. 

7. In the Button Properties dialog box, click the Up Appearance tab.
8. In the Caption field, type English and then click OK.

9. Repeat the steps above to add captions to the other two buttons:

• For the second button, the press action is Language it-IT (Italian for
Italy).

• For the second button, the caption is Italiano.
• For the third button, the press action is Language de-DE (German

for Germany).
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• For the third button, the caption is Deutsch.

Step 4. Add an Alarm and Event Summary to the graphic display 
1. On the Objects menu, point to Alarm and Event, and then click

Summary (or in the toolbox, click Alarm and Event Summary).
2. In the graphic display, hold the left mouse button down and drag the

mouse to create a box for the Alarm and Event Summary object.
3. When you have the object the required size, release the left mouse

button. The Alarm and Event Summary object is drawn on the display.

Step 5. Save and then close the graphic display 
1. On the File menu, click Save.
2. In the Save dialog box, type a name for the graphic display and then

click OK.

In this example, we used Alarm Summary Multilingual.

3. On the File menu, click Close to close the graphic display.

Enter alarm messages in 
other languages 
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In this section, we edit our application twice. The first time, we open the 
application in Italian, and enter the Italian alarm message in the Alarm 
Properties dialog box. 

Next, we export the alarms and events to an Excel spreadsheet, enter the 
German alarm message in Excel, and then import the alarm messages again 
into our application. 

When you enter alarm messages in multiple languages in Excel, you can add 
the text strings for all languages to one Excel file, and then import the 
translated text for all languages into the application in one operation. 

When you import alarm messages, the maximum length that is allowed is 255 
characters. Alarm messages longer than 255 characters are truncated. 

Step 1. Open the application in a new language 
1. On the File menu, click Close Application.
2. In the New/Open Site Edition (Local Station) Application dialog box,

click the Existing tab.
3. In the list of applications, click the name of your application (in this

example, My Local Site).
4. In the Language list, select Italian (Italy), it-IT and then click Open.
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Step 2. Enter the alarm message for the digital alarm 
1. In the Explorer window, expand the Tag Server, and then double-click

Alarm and Event Setup.

2. In the Alarm and Event Setup editor, click the Digital tab and then
double-click the TankTempThreshold alarm to edit it.
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3. In the Digital Alarm Properties dialog box, in the Message field, type
La temperatura del serbatoio e alta and then click OK.

Step 3. Export alarm messages to an Excel spreadsheet 
1. Right-click the Tag Alarm and Event Server where the alarms are

defined, and then click Import and Export.

In this example, right-click the Tag Alarm and Event Server called Tag 
Server.
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2. In the Alarm Import Export Wizard - Operation Type window, leave
Export alarm configuration to Excel file selected and then click Next.

3. In the Alarms to Export window, leave the TankTempThreshold alarm
in the list of alarms to export and then click Next.

If you have many alarms and you want to export only some of them, 
you can filter the list of alarms to find the ones you want, and then you 
can include only those alarms you need in the exported file. For details, 
click Help. 
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4. In the Messages to Export window, leave Export messages for all 
alarms selected, leave all of the languages selected, and then click
Next.

In this window you can choose whether to export all alarm messages, 
the messages for only the alarms you selected in the previous step, or 
no alarm messages, which then exports only the alarm data. If you are 
exporting alarm messages, you can also select which languages you 
want to export. 

5. In the Specify Output File window, leave the file name as it is. You can
specify a location where you want the file to be save or use the default
location that is displayed, and then click Finish.

To browse for a location, click the Browse button .

6. After the export is complete, click OK.

Step 4. Enter alarm messages in Excel 
1. Locate the exported alarm file and then double-click it to open it in

Microsoft Excel. The default location is in your My Documents folder.
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In this example, the file is called My Local Site_Tag 
Server_AlarmExport.xls. 

Each alarm is located in a new row in the spreadsheet. The column 
names correspond to the settings for each alarm. At the bottom of the 
Excel window there are tabs that organize the alarms by type (Digital, 
Level, Deviation). 
Two additional tabs contain the alarm messages and the tag update 
rates. These items are located on their own tabs because they can apply 
to multiple alarms. 
For example, if you had 50 alarms, you could use the same alarm 
message for 10 of them, but have different messages for the rest. 
Instead of editing the same alarm message 10 times, you only need to 
edit it once. Each alarm message has its own numeric identifier (in the 
Message column located in column H in our example), which links a 
message to each alarm (level alarms can have a different message for 
each level). 
The maximum length for an alarm message is 255 characters. 
Messages that are longer than 255 characters are truncated when they 
are imported. 

2. At the bottom of the Excel window, click the Messages tab.

3. To add a new language for messages, add a new column and then type
the associated language identifier as the column heading. For example,
click cell D1 and then type de-DE. This is the language identifier for
German.
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For example, the column heading, en-US is the language identifier for 
English (United States). For more information, see Language 
identifiers for language switching on page 191. 

4. To add messages, type the new message in a row under the column
specified for that language. For example, click cell D2 and then type
Hohe Tanktemperatur!

5. At the bottom of the Excel window, click the Tag Update Rates tab. The
columns are labeled with the update rates. For example cell A-1, is
labeled 0.10 Seconds and cell E-1 is labeled 2 Seconds.

6. To update an input tag every 2 seconds, enter the name of the input tag
in the column labeled 2 Seconds.

7. To save your changes, on the File menu, click Save.
8. Close Microsoft Excel.

Step 5. Import the alarm messages 
1. In FactoryTalk View Studio, right-click the Tag Alarm and Event Server

where the alarms are defined, and then click Import and Export.

In this example, right-click the Tag Alarm and Event Server called Tag 
Server.
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2. In the Alarm Import Export Wizard, in the Operation Type window,
select Import alarm configuration from Excel file and then click Next.

3. In the File to Import window, select the Excel spreadsheet to which
you added the German alarm message and then click Next.

To browse for the file, click the Browse button .

4. In the Alarms to Import window, select Import only alarm messages,
and then click Next.

In this window you can choose to overwrite any existing alarms, add 
only the new alarms--leaving all existing alarms unchanged, or delete 
all existing alarms and then import only those that are in the import 
file. 
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5. In the Messages to Import window, select Update existing messages 
and create new messages from the import file, and then click Finish.

Do not select either of the other two options in this window. In our 
Excel spreadsheet, we added a language to an existing alarm message; 
we did not create a new alarm message. If you do not choose to update 
existing messages, the translated text will not appear in your alarm 
messages. 

6. After the import is complete, click OK.

Because the Language command is ignored when you test run an application, 
you need to run the application from the FactoryTalk View Site Edition Client. 

Step 1. Run FactoryTalk View Site Edition Client 
1. In Windows, click Start > All Programs > Rockwell Software > 

FactoryTalk View > FactoryTalk View Site Edition Client. The
FactoryTalk View SE Client Wizard opens.

Step 2. Create a FactoryTalk View Site Edition Client configuration file 
1. In the FactoryTalk View Client Wizard, click Create a FactoryTalk

View SE Client configuration file.

Create a Display Client 
configuration file to test 
alarm messages 
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2. On the File name and location page, in Client file name, type a name
for the configuration file. In this example, we used Multilingual 
Alarms. Select a path for the configuration file and click Continue.

3. On the Startup components page, click Local Station.

In the Connect to the application list, select the name of the 
application you want to connect to. In this example, we used the My 
Local Site application that we created in Set up graphic displays on 
page 59. 
In the Initial display list, click Alarm Summary Multilingual, and then 
click Advanced. 

4. On the Client window properties page, configure how the FactoryTalk
View SE Client window will look at runtime. In this example, we
entered Show Me Alarms in the Title bar text box. At runtime, this text
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is displayed at the top of the Client window. Click Security and 
debugging. 

5. On Security and debugging page, you can configure the Client to log
out automatically after a period of inactivity.

6. Click Save, and then Run.

For details about triggering an alarm in the Logix Designer application (or 
RSLogix 5000 software), see step 6: "Test the alarm instruction by switching 
to run mode and triggering the alarm" in Configure the alarm and download 
to the controller on page 32. 

In a Tag Alarm and Event Server, the TankTempThreshold alarm we created 
triggers automatically once every minute. 

Test alarm messages at 
runtime 
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When an alarm conditions occurs, the alarm appears in the Alarm and Event 
Summary in the default runtime language (in this case, English for the United 
States). 

When you click the Italiano button, the alarm message appears in Italian. 
Notice that the other parts of the Alarm and Event Summary (for example, the 
Details pane) currently appear in the language version of the FactoryTalk 
View software you have installed on your computer. However, you can make 
these items switch languages by editing the properties of the Alarm and Event 
Summary to modify the column heading text. You can also export the graphic 
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display's language strings in FactoryTalk View, and then translate them before 
importing them again. 

The behavior of the display is the same when you click the Deutsch button to 
display the alarm message in German. 

The labels on the buttons do not change when switching languages. This is the 
expected behavior because there are no translated strings for the buttons, and 
the Display undefined strings using the default language check box is 
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selected. If you do not select this check box, undefined strings are displayed as 
question marks (?) at runtime. 

To set up language switching for an application: 

1. Develop the application in a base language.
2. Export the application's user-defined text strings.

When translating to or from Unicode character sets (for example,
Asian languages), you must export and then import the RSLogix 5000
tag database as a .txt file. The .csv format does not support Unicode
character sets. This limitation does not apply to FactoryTalk Tag Alarm
and Event Servers.

3. Translate the strings. You can use Notepad or Microsoft Excel. Excel is
useful for large numbers of strings.

4. Import the translated strings back into the application.
Tip: For more detailed information about setting up language switching, see the FactoryTalk 
View Site Edition Help in FactoryTalk View Studio. Also see the FactoryTalk View User's Guide in 
FactoryTalk View--click Help > Online Books. 

In general, the user-defined strings that support language switching are 
those that an operator sees in an application at runtime. Specifically, these 
are: 

• Text you specify for graphic objects and global objects including
captions, tool tip text, time and date embedded variables, and numeric
embedded variables.

• Graphic and global object display titles specified in the Display
Settings dialog box.

• Text objects created in graphic displays and global object displays.

Text that does not support language switching: 

• Text that is part of the language version of the FactoryTalk View Studio
Site Edition or Client software, such as information from system tags,

Summary and tips for 
setting up language 
switching 

Text that supports language 
switching 

Text that does not support 
language switching 
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which is displayed in the same language as the operating system. 
These are translated when FactoryTalk View is localized. 

• Text that can be displayed at runtime but is used to operate the
application, such as the names of graphic displays, and command
strings.

• Tag descriptions and string constants in expressions.
• Text in the title bar of a FactoryTalk View Site Edition Client window,

which is part of the setup of the client, not part of the application.

If the Alarm and Event Summary or the Alarm and Event Banner is notified of 
a language switch, the contents are reloaded in the new language. 

Any Alarm Fault List messages that you created in RSLogix 5000 (in the 
Alarm Properties dialog box) do not currently switch languages. 

You can use the Alarm and Event Banner Properties dialog box to configure 
tooltips and panel captions in multiple languages. Define strings in one 
language at a time. FactoryTalk View controls which language is displayed. 
You cannot switch the text labels for the alarm states and priorities. 

Tip: When configuring language switching for the Alarm and Event Banner, see the FactoryTalk View Site 
Edition Help in FactoryTalk View Studio. 

You can use the Alarm and Event Log Viewer to configure column headings, 
button captions, and button tooltips in multiple languages. Define strings in 
one language at a time. FactoryTalk View controls which language is 
displayed. 

When the Alarm and Event Log Viewer is notified of a language switch, the 
contents of the viewer, which consists of report data, are not translated. This 
data continues to be displayed in the language that was used when the alarm 
or event was logged. 

If text for a language is not available, the text for the default language is used. 

Tip: When configuring language switching for the Alarm and Event Log Viewer, see the FactoryTalk View 
Site Edition Help in FactoryTalk View Studio. 

Alarm and Event Summary 
and Alarm and Event Banner 

Alarm and Event Log Viewer 
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Appendix B 

System performance and limits 

FactoryTalk Alarms and Events has been tested to conform to the following 
performance limits. 

Tip: All testing was performed with the recommended hardware. For details, see the FactoryTalk View 
Site Edition Installation Guide. 

The specifications vary depending on the controller firmware revisions. 

Specification Value 
Number of subscribers (FactoryTalk Linx servers) per 
controller 3 

Typical number of alarm state transitions per subscriber 1000 
Recommended maximum number of alarms per controller 3000 

Approximate controller memory used for each alarm 

Digital 1 KB 
Analog 2.5 KB 
Using associated tags, string tags consume 750-1600 bytes per 
string tag depending on the alarm type. 

Supported languages for alarm messages All languages supported by FactoryTalk View. 

Execution times for alarms 
Rung State Execution times 

ALMD instruction ALMA instruction 
False with no alarm state change 7 μs 5 μs 
False with alarm state change 16 μs 5 μs 
True with no alarm state change 7 μs 15 μs 
True with alarm state change 16 μs 25 μs 

Specification Value 
Number of subscribers (FactoryTalk Linx servers) per 
controller 3 

Controller memory used for buffering by each subscriber 
(FactoryTalk Linx) 100KB 

Typical number of alarm state transitions per subscriber 1000 
Recommended maximum number of alarms per controller 2000 

Controller specifications 
Controllers with revision 24 
and later 

Controllers with revision 20 
or earlier 
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Approximate controller memory used for each alarm 

Digital 1 KB 
Analog 2.2 KB 
Using associated tags, string tags consume 750-1600 bytes per 
string tag depending on the alarm type. 

Supported languages for alarm messages All languages supported by FactoryTalk View. 

Execution times for alarms 
Rung State Execution times 

ALMD instruction ALMA instruction 
False with no alarm state change 8 μs 17 μs 
False with alarm state change 35 μs 17 μs 
True with no alarm state change 8 μs 65 μs 
True with alarm state change 35 μs 126 μs 

Scan times increase during a scan when many alarms change state at the 
same time. An alarm state change is any event that changes the condition of 
the alarm. Minimize the potential for large alarm bursts by creating 
dependencies on related alarms. Large alarm bursts can have a significant 
impact on application code scan time. 

Tip: Firmware revisions 21 to 23 do not support the new alarms functionality. 

When you design and set up a FactoryTalk system, we recommend using the 
following guidelines. If you find that your system needs to expand beyond 
these guidelines, contact your Rockwell Automation sales or distributor 
representative to discuss your application design. 

Component Recommended guidelines 

FactoryTalk Alarms and Events 

FactoryTalk Alarms and Events servers per application 10 non-redundant servers or 10 redundant server pairs 

FactoryTalk tag-based alarms per server 20,0001 
Logix device-based alarms per server 10,0002 

Total alarms per application 100,0003 

FactoryTalk Linx 
FactoryTalk Linx data servers per application 10 non-redundant servers or 10 redundant server pairs 

Total device tags per application 1,000,0004 
Tags per FactoryTalk Linx data server 100,0004 

FactoryTalk View SE 
HMI servers 10 non-redundant servers or 10 redundant server pairs 

HMI tags per HMI Server 40,0005 
Total data logged tags per HMI server (1 second scan rate) 5,000 
FactoryTalk View SE client sessions simultaneously connected to the application 1204 

FactoryTalk ViewPoint SE servers per application 4 
FactoryTalk ViewPoint SE concurrent clients per ViewPoint server 50 

System sizing 
recommendations 
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Component Recommended guidelines 

1. The number of alarm backing tags influences the maximum number of available alarms because they increase the resource requirements of the alarm server. When using backing tags for
status and control, a good rule of thumb is to multiply the total number of backing tags by the total number of alarms, and ensure the result is less than 20,000. PlantPAx® users should refer 
to the PlantPAx Reference Manual PROCES-RM001 for alarm server sizing guidance for a PlantPAx application.

2. This number is the sum of both instruction alarms and Logix tag-based alarms across all the controller shortcuts in each FactoryTalk Linx server. 
3. The total number of alarms per application includes all FactoryTalk Alarms and Events tag-based and device-based alarms in the application.
4. Refer to Knowledgebase Document ID: IN7377 - Amounts of device tags that may have in FactoryTalk View SE application for detailed information to determine system scalability for the total 

device tags per application. 
5. The maximum number of HMI tags that can be created on a single HMI server is 175,000. Extensive use of HMI tags has a significant performance impact on an HMI server, so Rockwell 

Automation recommends minimizing their use, and instead using direct-reference tags as much as possible.

http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm001_-en-p.pdf
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1070902
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Appendix C 

Install FactoryTalk Alarms and Events manually 

FactoryTalk Alarms and Events software is installed when you install 
FactoryTalk View Site Edition and FactoryTalk Linx software. It is not 
installed as part of the FactoryTalk Services Platform. If you installed the 
platform on a computer where FactoryTalk View Site Edition and FactoryTalk 
Linx are not installed, you will not have the FactoryTalk Alarms and Events 
software and must install it manually. 

The following illustration shows a sample FactoryTalk system with Alarms and 
Events installed on various computers. 

Step 1. Confirm that FactoryTalk Services Platform is installed on the 
computer where you are going to install FactoryTalk Alarms and Events. 

Step 2. Install FactoryTalk Alarms and Events. 

FactoryTalk Services Platform must be installed before installing FactoryTalk 
Alarms and Events. 

To check if you have FactoryTalk Services Platform: 

Summary of steps 

Confirm that FactoryTalk 
Services Platform is 
installed 
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1. On the Start menu, click Control Panel and then click Programs and 
Features.

2. In the list, look for FactoryTalk Services Platform 2.10 (CPR 9) or later.
If it is not in the list, install it. For instructions, see either the
FactoryTalk View Site Edition Installation Guide or the FactoryTalk Linx
installation instructions.

Log in as a user with administrative rights before you begin the installation. 
As part of the installation process, FactoryTalk Alarms and Events creates 
program folders and modifies registry entries. To make these modifications, 
the user that is currently logged in must have administrative rights on the 
computer on which FactoryTalk Alarms and Events is installed. 

1. Close any open programs.
2. At the root of the FactoryTalk View SE or FactoryTalk Linx installation

package, open the FTAE folder and then double-click FTAE.msi.
3. In the Welcome dialog box, click Next.
4. Click the option to accept the End User License Agreement and then

click Next.
5. Select the Complete Installation option and then click Next.
6. Click Install to begin the installation.
7. When the installation is finished, click Finish to close the window.

Install FactoryTalk Alarms 
and Events 



Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 165 

Appendix D 

Install SQL Server 2014 SP3 Express 

FactoryTalk Alarms and Events uses Microsoft SQL Server as the database 
engine for logging alarm and event information. You can connect to an 
existing SQL Server database. You can also install SQL Server 2014 SP3 
Express, which is included in the FTView\Redist folder in the FactoryTalk 
View installation package. 

If you do not have an existing SQL Server database, or do not plan to use it, 
follow the instructions outlined in this chapter to make sure that SQL Server 
2014 SP3 Express is installed with the correct features enabled. See Summary 
of Steps on page 165 for details. 

You can install the database on the same computer used to host other 
FactoryTalk servers, or on a separate computer. Depending on the size of your 
system, you might choose to use a separate computer as a dedicated logging 
computer to balance processing power. 

For more information on using an existing SQL Server database, see Use an 
existing SQL Server database on page 169. 

The following is a summary of the steps required to install SQL Server 2014 
SP3 Express. Each step is described in more detail on the following pages. 

Step 1. Open the FTView folder, which is at the root of the FactoryTalk View 
installation package. The subfolders Redist contains the software for SQL 
Server 2014 SP3 Express. 

Step 2. Install the .NET Framework. The SQL Server 2014 SP3 Express 
installation fails without this component. 

Step 3. Run the SQL Server Install batch file to install and configure SQL 
Server 2014 SP3 Express. 

Step 4. Configure the Windows firewall if you want to allow for remote 
connections. 

The FTView folder is located at the root of the FactoryTalk View installation 
DVD and contains the following folders: 

Folder Description 
Redist\DotNETFX_4.8* Installation for Microsoft .NET Framework version 4.8. You might already have the 

.NET Framework software on your computer, but verify the correct version is 
installed or the SQL Server install fails. 

Redist\SQLServerEXPR_2014SP3 Installation for SQL Server 2014 SP3 Express. 

Summary of steps 

Step 1. Open the FTView 
folder 
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(*) This software component is a prerequisite that must be installed before 
you install SQL Server 2014 SP3 Express. If the installation program identifies 
other missing components, download them from the Microsoft website. 

The Microsoft .NET Framework version 4.8 is a prerequisite for SQL Server 
2014 SP3 Express. You need to manually install it if it is not installed. 

Tip: If you have .NET Framework 1.2 or any version before 2.0.50727, you must uninstall it (versions 1.0 
and 1.1 do not have to be uninstalled) before installing the correct version. 

To determine which .NET Framework versions are on your computer, see 
Microsoft Knowledge Base article 318785. 

To manually install the .NET Framework version 4.8 
1. At the root of the FactoryTalk View installation DVD, open the

FTView\Redist\DotNETFX_4.8 folder, and then double-click ndp48-
x86-x64-allos-enu.exe.

2. Follow the on-screen instructions.

The batch file installs SQL Server 2014 SP3 Express on your computer with the 
correct settings for logging alarms and events. The batch file configures the 
following settings for SQL Server: 

• Allow remote connections to the database using the TCP/IP protocol.
• Enable SQL Server Browser.

To install SQL Server 2014 SP3 Express 
1. Close any open programs.
2. At the root of the FactoryTalk View installation DVD, open the

FTView\Redist\SQLServerEXPR_2014SP3 folder, and then double-
click SQL Server Install.bat.

3. In the Setup Support Rules window, click OK.
4. In the Product Key window, click Next (SQL Server 2014 SP3 Express

does not need a product key).
5. Review the End User License Agreement, select the check box to accept

it, and then click Next.
6. In the Setup Support Files window, click Install.

If the system configuration check identifies any missing software
components, installation fails, and the missing components show in
the System Configuration window. Download the missing
components listed from the Microsoft web site.

7. In the Setup Support Rules window, click Next.
8. In the Feature Selection window, click Next.
9. In the Instance Configuration window, click Next.
10. In the Disk Space Requirements window, click Next.

Step 2. Install the .NET 
Framework 

Step 3. Run the SQL Server 
Install batch file (not the 
.exe) 

http://msdn.microsoft.com/en-us/kb/kbarticle.aspx?id=318785
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11. In the Server Configuration window, specify a service account for the
SQL Server Database Engine. Click Next.

12. In the Database Engine Configuration window, select Mixed mode
and then enter a password for the built-in SQL Server system
administrator account. If there is no user listed in the Specify SQL 
Server administrators edit box, you must add a user. Click Next.

13. In the Error and Usage Report window, leave the check boxes
unselected, and then click Next.

14. In the Installation Rules window, click Next.
15. In the Ready to Install window, click Install.
16. When the components finish installing, click Next.
17. In the Complete window, click Close.

If you want to allow remote connections to the SQL Server database, the 
database engine service and the SQL Server Browser service must be added to 
the Windows Firewall Exception List. Perform these steps if you: 

• Have remote clients (for example, a log viewer) that needs access to the
database.

• Want to configure the database remotely.

To configure the Windows firewall 

1. In Windows, click Start > Control Panel > Windows Firewall.
2. On the Exceptions tab, SQL Server (sqlservr.exe) might be listed in the

Programs and Services box, but not selected as an exception. If you
select the check box, Windows will open port 1433 to allow TCP
requests. Alternatively, if you do not see SQL Server listed:

• Click the Add Program button.
• Click the Browse button.
• Open the folder at <drive letter>:\Program Files\Microsoft SQL

Server\MSSQL12.SQLEXPRESS\MSSQL\Binn.
• Select sqlservr.exe and then click Open.
• In the Add Program dialog box, click OK.

Sqlservr.exe is displayed in the list with a check mark beside it.

3. To add the SQL Server Browser service to the exception list:

• Click the Add Program button.
• Click the Browse button.
• Open the folder at <drive letter>:\Program Files\Microsoft SQL

Server\90\Shared.
• Select sqlbrowser.exe, and then click Open.
• In the Add Program dialog box, click OK.

Sqlbrowser.exe is displayed in the list with a check mark beside it.

4. Click OK to accept the changes and close the Windows Firewall dialog
box.

Step 4. Configure the 
Windows firewall 
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Appendix E 

Use an existing SQL Server database 

FactoryTalk Alarms and Events can use an existing Microsoft SQL Server as 
the database engine for logging alarm and event information.  

You must set up the correct settings for logging alarm and event data if you 
are using an existing SQL Server database. For more information on the 
settings, see Summary of steps on page 169. 

FactoryTalk Alarms and Events can use any of the following Microsoft SQL 
Server databases: 

• SQL Server 2019 Standard (64-bit)
• SQL Server 2017 Standard (64-bit)
• SQL Server 2016 Standard SP2 (64-bit)
• SQL Server 2014 Standard SP3 (64-bit)
• SQL Server 2012 Standard SP4 (64-bit)

To allow remote connections to the database you must configure the TCP/IP 
protocol, the SQL Server Browser, and the Windows Firewall. Perform these 
steps if you: 

• Have remote clients (for example, a log viewer) that needs access to the
database.

• Want to configure the database remotely.

Step 1. Install SQL Server Management Tools on page 169 

Step 2. Specify Mixed Mode authentication for the SQL Server database on 
page 170 

Step 3. Configure TCP/IP protocol for the database on page 170 

Step 4. Enable the SQL Server Browser service on page 170 

Step 5. Configure the Windows Firewall on page 171 

Prior to SQL Server 2016, management tools are included in a SQL Server 
installation. Starting from SQL Server 2016, you need to download and install 
management tools, such as SQL Server Management Studio separately. 

To add the SQL Server Management Tools to an existing instance of SQL 
Server prior to SQL Server 2016, complete these steps: 

1. Close any open programs.
2. In Windows, open Control Panel, and then open Programs and 

Features.
3. In the list that appears, double-click your SQL Server version.

Supported SQL Server 
databases 

Remote connections to the 
SQL Server database 

Summary of steps 

Step 1. Install SQL Server 
Management Tools 
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4. The following steps use SQL Server 2012 Standard as an example.

a. In the SQL Server 2012 dialog box, click Add.

b. Enter the location of the Setup.exe file on the SQL Server
installation media to open the Microsoft SQL Server Setup wizard.

c. Follow the instructions in the wizard until you get to the Feature 
Selection page.

d. On the Feature Selection page, select the Management Tools - Basic
check box. If you do not want to install the complete management
tools, clear the Management Tools - Complete check box.

e. Click Next.

5. Follow the remaining instructions in the wizard to complete the
installation. If you are prompted to restart, click Yes.

To change the authentication mode and configure the sa login, complete 
these steps: 

1. Open SQL Server Management Studio.
2. In Object Explorer, right-click the server node, and then click

Properties.
3. On the Security page, under Server authentication, select SQL Server

and Windows Authentication mode, and then click OK.
4. In Object Explorer, expand Security, expand Logins, right-click sa, and

then click Properties.
5. On the General page, you may have to create and confirm a password

for the sa login.
6. On the Status page, under Login, click Enabled, and then click OK.
7. If you changed the authentication mode, restart the server. In Object

Explorer, right-click the server node, and then click Restart.

To configure TCP/IP protocol for the database, complete these steps that use 
SQL Server 2012 Standard as an example. 

1. Open SQL Server Configuration Manager.
2. In Object Explorer, expand SQL Server Network Configuration, and

then click Protocols for MSSQLSERVER.
3. In the details pane, right-click TCP/IP, and then click Enabled.
4. Set all other protocols listed in the details pane to Disabled.
5. To finish, restart the SQL Server. In the Object Explorer of SQL Server

Management Studio, right-click the SQL Server instance, and then
click Restart.

To enable the SQL Server Browser service, complete these steps that use SQL 
Server 2012 Standard as an example. 

1. Open SQL Server Configuration Manager.
2. Click SQL Server Services.
3. In the details pane, right-click SQL Server Browser. Click Properties.

Step 2. Specify Mixed Mode 
authentication for the SQL 
Server database 

Step 3. Configure TCP/IP 
protocol for the database 

Step 4. Enable the SQL 
Server Browser service 
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4. In the Properties dialog box, on the Service tab, set Start Mode to
Automatic, and then click OK.

To configure the Windows Firewall, perform the following steps: 

1. Click Start > Control Panel > Windows Firewall.
2. On the Exceptions tab, SQL Server (sqlservr.exe) might be listed in the

Programs and Services box, but not selected as an exception. If you
select the check box, Windows will open port 1433 to allow TCP
requests. Alternatively, if you do not see SQL Server listed:

1. Click Add Program.
2. Click Browse.
3. Open the folder at <drive letter>:\Program Files\Microsoft SQL

Server\MSSQL10.SQLEXPRESS\MSSQL\BINN.

If you use SQL Server 2014 SP3 Express, the folder is at <drive 
letter>:\Program Files\Microsoft SQL 
Server\MSSQL12.SQLEXPRESS\MSSQL\BINN.

4. Select sqlservr.exe, and then click Open.
5. In the Add Program dialog box, click OK.

Sqlservr.exe is displayed in the list with a check mark beside it.

3. To add the SQL Server Browser service to the exception list:

1. Click Add Program.
2. Click Browse.
3. Open the folder at <drive letter>:\Program Files\Microsoft SQL

Server\90\Shared.
4. Select sqlbrowser.exe, and then click Open.
5. In the Add Program dialog box, click OK.

Sqlbrowser.exe is displayed in the list with a check mark beside it.

4. To accept the changes and close the Windows Firewall dialog box,
click OK.

Step 5. Configure the 
Windows Firewall 
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Appendix F 

Alarm time stamping 

FactoryTalk Alarms and Events provides excellent time-stamp accuracy 
compared with traditional alarm monitoring systems, and you can obtain 
better time-stamp resolution in some cases by using time stamps directly 
retrieved from peripheral devices such as I/O cards or other time-stamping 
hardware. 

When an analog (ALMA) or digital (ALMD) alarm instruction executes as an 
alarm event occurs, the current Universal Coordinated Time (UTC) value of 
the controller’s wall clock is captured and delivered to the FactoryTalk Alarms 
and Events system with the alarm. 

This appendix shows how to replace the controller’s wall clock time in an 
alarm event with a time stamp from an external source. 

You can take events from an I/O card such as a 1756-IB16ISOE and use the 50-
microsecond accuracy from the card’s time stamp when delivering an alarm 
to the rest of the alarm monitoring system. 

Resolve these points when you replace the normal time stamp provided with 
the alarm instructions: 

• Alarm time stamps must be in UTC with no time zone or daylight
savings time offset included (these offsets are automatically added to
the time stamp when it is displayed).

• The alarm time stamp is usually represented as a long integer (LINT)
data type, occupying one 64-bit word. Most I/O cards stamp time using
two double integers (DINT), occupying two 32-bit words.

In the RSLogix 5000 environment, time is represented in three different 
ways: Local Time, Coordinated System Time, and Universal Coordinated 
Time. 

Coordinated System Time is provided by a free-running backplane clock that 
starts counting the first time the system is powered up. CST is used for time 
stamping, event tracking between processors and I/O cards, as well as for 
motion planning among multiple motion modules. CST has no relevance to 
real-world time, but can be converted to Coordinated Universal Time (UTC) 
using an offset. CST time stamps must be converted to UTC before passing 
them to the alarm monitoring system. 

Coordinated Universal Time is a real-world time relative to a time constant, 
but with no time zone information and no daylight savings time offsets. It is 
the raw value used to represent time and also the value required for time 

Overview of time keeping 

Coordinated System Time 
(CST) 

Coordinated Universal Time 
(UTC) 
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stamps in the FactoryTalk Alarms and Events system. UTC is equivalent to 
Greenwich Mean Time, with no daylight savings time offsets. 

Advantage of using UTC for time stamps is that distributed events can be 
compared, regardless of their geographical location or where they are, relative 
to Daylight Savings Time (DST). The software reading the time stamp can 
then convert UTC time stamps to local time. Logix 5000 and FactoryTalk 
Alarms and Events graphic objects convert UTC time stamps to the local time 
of the workstation running the software application. 

Time stamps from different sources may or may not be returned in UTC 
format, depending on the device generating the time stamp and how it is 
configured. For example, a 1756-IB16ISOE module can return time in UTC if 
configured to do so. 

In the RSLogix 5000 software, time is often returned as two 32-bit DINT data 
types instead of one 64-bit LINT data type. The FactoryTalk Alarms and Events 
system requires the time stamps to use the LINT data type. If a module (for 
example, the 1756-IB16ISOE module) returns the time stamp in two DINTs 
instead of a LINT, you will have to convert the time format into a LINT. To 
perform this conversion, an Add-On Instruction is available for download 
from the RSLogix 5000 sample code website in the Rockwell Automation 
Sample Code Library. You can locate this code by performing a search for 
LINT on the search page. 

Local time (often referred to as Wall Clock Time) is the time in the real world 
where the controller is located. This means that Wall Clock time is UTC, but 
with time zone and Daylight Savings Time (DST) offsets added. 

Local Time is typically used to trigger local events (like turning on a pump at 
1:00AM during shift change). Local time values must be converted to UTC 
before passing them to an alarm monitoring system. 

Local Time (Wall Clock 
Time) 

http://samplecode.rockwellautomation.com/
http://samplecode.rockwellautomation.com/


Appendix F Alarm time stamping 

Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 175 

You can see the calculated result in RSLogix 5000, in the Controller 
Properties dialog box, on the Date/Time tab, as shown in the following 
illustration. 

We recommend using local time only to drive events from the controller, and 
not to time-stamp alarms. 

When the controller detects a condition that causes an In Alarm event, the 
controller stores the current UTC value in the backing tag for the alarm. 

ALMD and ALMA alarm 
blocks 
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1. The alarm is provided by ladder logic that includes the ALMD or ALMA
instructions:

If you are using RSLogix 5000 version 20 or earlier, the instruction 
block is like this: 

2. In the ALMD Properties dialog box, in the Configuration tab, click the
Browse button (...) to edit the alarm message sent when the alarm is
triggered.
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3. On the Status tab, time stamps appear when the alarm is triggered,
acknowledged, returns to normal, or when the alarm count is reset.

4. On the Parameters tab, these UTC time stamps are automatically
transferred to tags that you can then use in logic of your own.

For details about adding an Alarm and Event Summary object to a graphic 
display in FactoryTalk View, see Set up graphic displays on page 59. 

To insert a time stamp manually, in the ALMD Properties dialog box, on the 
Tag tab, enter the new time under the .ProgTime element. Set the boolean 
.UseProgTime in the backing tag for the alarm before the actual alarm 
instruction is triggered. 

Insert time stamps manually 

Example 
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Appendix G 

Time synchronization 

FactoryTalk Alarms and Events provides excellent resolution and accuracy for 
alarms and events time stamps. You can build a very accurate time sequence 
for events that led to a failure, or simply to diagnose the exact order of their 
occurrence. Because the alarms are generated by the controller, the time-
stamp accuracy is a function of the rate of the controller’s ability to scan the 
alarm instruction, plus the accuracy of the controller’s wall clock.  

When an alarm instruction is evaluated in code and an alarm transition event 
occurs (goes into alarm, or is acknowledged, suppressed, and so on), the 
instruction immediately records the current value of the controller’s wall 
clock. This 64-bit, microsecond-resolution number reflects the time of the 
event relative to the controller’s wall clock in UTC time (no time zone or 
daylight savings information is included). When you view this time stamp, 
either in the Logix Designer application (RSLogix 5000 software) or in 
FactoryTalk View Site Edition, the time zone of the computer running the 
software is used to visualize the time value. You can use a distributed system 
that covers multiple time zones to display a valid sequence of events at an 
operator or maintenance station independently of the time zone the time 
stamps are captured in. 

Because alarm events can originate in multiple controllers distributed over an 
enterprise, it is important to provide a common time reference to set these 
clocks. A controller with a wall clock that is out of synchronization with the 
rest of the enterprise can potentially log events out of the time sequence in 
which they actually occurred, relative to the other controllers. 

Setting the controllers' wall clocks individually by hand is inefficient. 
Additionally, clock drift naturally causes these clocks to record time further 
and further apart from each other. There are several automated methods to 
manage the wall clocks on multiple controllers, the easiest and most cost-
effective of which is the Logix5000 Clock Update Tool. 

The Logix5000 Clock Update Tool lets you view and synchronize the system 
time of the controllers and devices on a network, using any computer running 
Microsoft Windows and RSLinx Classic. You can also schedule automatic 
synchronization of all devices. See Create a synchronization schedule on page 
181. 

The accuracy of time synchronization varies based on many factors, including 
the network path and what the controller is doing when the time 
synchronization takes place. Typical systems using the Logix5000 Clock 
Update Tool coordinate clocks to approximately 300ms. If you need greater 

Coordinate multiple 
controller wall clocks 
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accuracy for clock synchronization than the Logix5000 Clock Update Tool can 
provide, there are several other hardware-based options to improve the 
accuracy of time stamps in the control system. These include IRIGB, NTP, 
GPS, and IEEE 1588 Ethernet. 

This stand-alone tool is included with the RSLogix 5000 software. Using 
RSLinx to browse to multiple controllers, this tool synchronizes multiple wall 
clocks at a user-defined rate in a variety of controllers, including PLC-5, SLC 
500s, MicroLogix, and all Logix 5000 controllers (except the SoftLogix 
controller which typically obtains the time from the clock in the computer 
where the controller is installed). 

1. On the RSLogix 5000 software install media, open the Tools folder and
then double-click Setup.exe. You can also install this tool when
installing the RSLogix 5000 software (the Logix Designer application).

2. Follow the instructions on the screen to install the Logix5000 Clock
Update Tool.

• Click Start > All Programs > Rockwell Software > RSLogix 5000 Tools > 
Logix5000 Clock Update Tool > Logix5000 Clock Update Tool.

You can start the Logix5000 Clock Update Tool automatically when you start 
Windows. 

• In the Logix5000 Clock Update Tool, on the File menu, click Start the
application when Windows starts.

The next time you start Windows, the Clock Update Tool opens automatically. 

The Logix5000 Clock Update Tool lets you view and synchronize the system 
time of the controllers and devices on a network, using any computer running 
Microsoft Windows and RSLinx Classic. You can also schedule automatic 
synchronization of all devices. 

Install the Logix5000 Clock 
Update Tool 

Start Clock Update Tool 

Start the Update Tool 
automatically 

Use the Logix5000 Clock 
Update Tool 
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The left pane of the Clock Update Tool window contains a tree view, with 
these items: 

• Scheduled Synchronizations lists synchronization schedules that have
been configured. Right-click an individual schedule for more options.

• Devices lists devices that have been configured. Right-click an
individual device for more options.

• Log contains a log of the most recent events. The path indicated under
the list of events contains the location of the complete log file for the
day.

To synchronize devices on a schedule, complete these steps: 

1. Create a synchronization schedule. This schedule determines when
synchronization takes place.

2. Create a list of devices you want to synchronize and then add them to
synchronization schedules. Devices that are not included in this list are
not synchronized.

3. Optionally, match existing devices with existing synchronization
schedules. Skip this step if you specified a synchronization schedule
when you added the device. Devices that are not matched to any
synchronization schedule are not synchronized.

This section includes information about each of these steps. 

A synchronization schedule determines when devices are synchronized. For 
example, you can schedule devices to be synchronized on a fixed time 
interval. You can also configure a synchronization schedule to expire on a 
particular date. 

1. In the Logix5000 Clock Update Tool window, in the left pane, click
Scheduled Synchronizations.

2. Right-click the right pane and then click Add Event.

Synchronize devices on a 
schedule 

Create a synchronization 
schedule 

Create a synchronization 
schedule 
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3. In the Update Date and Time Interval dialog box, set up a schedule for
synchronizing the date and time, and then click OK.

The new schedule information appears, as shown in the following 
example: 

To remove a synchronization schedule from the list: 

1. Right-click the synchronization schedule you want to remove and then
click Remove Event.

2. Any devices that were associated with this synchronization schedule
are no longer associated with a schedule.

1. To modify an existing synchronization schedule, right-click the
synchronization schedule and then click Modify Event.

2. In the Update Date and Time Interval dialog box, modify the schedule
information, and then click OK.

Occasionally, you might want to temporarily disable a synchronization 
schedule, rather than permanently delete it. 

• To disable a synchronization schedule, right-click the synchronization
schedule you want to disable and then click Disable Event.

Remove a synchronization 
schedule 

Modify a synchronization 
schedule 

Enable or disable a 
synchronization schedule 
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• To enable a synchronization schedule, right-click the disabled
synchronization schedule you want to enable, and then click Enable
Event.

After creating one or more synchronization schedules, add the devices you 
want to include in the schedules. 

When you add a device, you can also match it to a synchronization schedule, 
or you can add all of the devices first and then match them to synchronization 
schedules later. If you add the devices later, you can add all of the devices to a 
single synchronization schedule in one step. 

You can add a device to only one synchronization schedule. 

1. In the Logix5000 Clock Update Tool, in the left pane, click Devices.
2. Right-click anywhere in the right pane and then click Add New Device 

or click the Add Device button .

3. In the RSLinx dialog box, browse to the device you want to add, select
it, and then click OK.

Tip: You cannot click OK unless you have selected a device that is capable of being 
synchronized and has not already been configured. 

4. In the Add Device to Schedule list, select the synchronization schedule
to which you want to add the device, and then click OK.

Add devices 

Add a device 
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The device is added to the list. Because this device has not yet been 
synchronized, question marks (?????) appear in the Last Update 
column. 

• To remove a device from the list, right-click the device you want to
remove, and then click Remove Device. You can also select the device

your want to remove, and then click the Remove Device button . If 
the device is associated with a particular synchronization schedule, it 
is removed from that schedule. 

• If you want to remove all devices from the list, right-click in the Device
pane and then click Remove All Devices. All devices are removed from
the list, as well as from their respective synchronization schedules.

To view the details of a particular device, right-click the device and then click 
Device Properties. This shows major and minor firmware revision 
information, Computer Time, Device Time, Response Time, and the Time 
Difference between the computer and the device. 

Remove a device 

View details about a device 

Assign devices to 
synchronization schedules 
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When a synchronization schedule is selected in the left pane, the Device pane 
lists all of the devices that are configured. 

Tip: When you add a new device, you can assign it to a specific schedule at that time. See Add devices 
on page 183. 

• To add a device to the selected synchronization schedule, select the
check box to the left of the device. To remove the device from the
synchronization schedule, clear the check box.

• To add all devices to the specified schedule, select the Select All check
box at the bottom of the list.

In addition to scheduling automatic synchronization, you can synchronize 
devices manually. Either: 

• Click the Synchronize All Devices button on the toolbar. 
• Right-click a device and then click Synchronize Device or right-click

anywhere in the Device pane and then click Synchronize All Devices.

Any errors in synchronization are saved to the log file. In addition, an icon 
appears in the device list and in the main tree view to indicate the error. The 
log file indicates a specific cause for the error, where one is known. 

Synchronize devices 
manually 

View the log file 
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To view a log of the most recent events, in the left pane click Log. The path 
shown under the list of events contains the location of the complete log file for 
the day. The log file is saved in .txt and .xml format. 

The default location for the synchronization log file is C:\Program 
Files\Rockwell Software\RSLogix 5000 Tools\Logix5000 Clock Update Tool. 

To change the location of the log file: 

1. On the Log menu, click Change Log File Location (or to the right of the
Path box at the bottom of the Update Tool window, click the Browse

button ).

Change the location of the 
log file 
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2. In the Browse for Folder dialog box, select the new folder for the log
files, and then click OK. To create a new folder for the log file, click
Make New Folder.

If your FactoryTalk Alarms and Events system includes tag-based alarm 
servers, the time stamps for those alarms come from the computer that hosts 
the server that provides tags to the alarm server (for example, FactoryTalk 
Linx or a third-party Data Server). To ensure that alarms are ordered properly 
by time, you must synchronize the computer's clock with the controllers' 
clocks. 

The simplest way to solve this synchronization problem is to run the 
Logix5000 Clock Update Tool on the same computer as the FactoryTalk Linx 
alarm server. This ensures that the controller clocks all synchronize with the 
computer's tag-based alarm server. Typical systems using this method 
commonly achieve 300ms synchronization. 

If it is not possible to install the Logix5000 Clock Update Tool on the same 
computer that hosts the data server that provides tags for the tag-based alarm 
server, try to synchronize the computer's clock with the same NTP server that 
is used to synchronize the control network, with similar network latencies. 

For details about tag-based alarms, see Add a tag-based alarm server for Logix 
5000, PLC-5, SLC 500, or third-party controllers on page 51. 

The Logix5000 Clock Update Tool supports the following controller families: 

• ControlLogix
• CompactLogix

• All CompactLogix processors can be used with ENI. CompactLogix
L32E and CompactLogix L35E can be directly connected via Ethernet
or with ENI.

• Make sure that the CompactLogix port is set up for DF1 full-duplex.

Time stamps with tag-based 
alarms 

Supported devices 
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• Make sure routing is enabled on NET-ENI. Net-ENI works with
Ethernet devices drivers and not with EtherNet/IP drivers.

• DriveLogix
• FlexLogix
• PLC-5
• SLC
• MicroLogix
• PowerMonitor
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Appendix H 

Reference for building a distributed system 

This system configuration guide primarily focuses on building an alarms and 
events system on a single computer. 

When building a distributed system on multiple computers on the network, 
keep the following guidelines in mind. 

FactoryTalk Alarms and Events is installed with FactoryTalk View and 
FactoryTalk Linx. There is no need to install FactoryTalk Alarms and Events 
separately unless you have installed FactoryTalk Services Platform on a 
computer where you have not installed FactoryTalk View or FactoryTalk Linx. 

For details, see Install FactoryTalk Alarms and Events manually on page 163. 

In the sample distributed automation system shown next, FactoryTalk 
Services Platform is installed on every computer in the network. 

The diagram shows just one example of a possible network layout for a group 
of computers and software products participating in a FactoryTalk Alarms 
and Events system using a FactoryTalk Network Directory. Use this diagram 
only as a starting point--your own distributed system will vary. 

When installing FactoryTalk 
Alarms & Events 

Typical distributed system 
on a network 
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Appendix I 

Language identifiers 

With the FactoryTalk View language switching feature, runtime operators can 
view the text strings defined in an application in up to 40 different languages. 
FactoryTalk View SE Clients can run in any of the languages an application 
supports. In a network distributed application or network station application, 
multiple clients can run in different languages at the same time.  

The languages in the following table are supported for language switching by 
the application at runtime. Be sure that these languages are installed on the 
development and client computers before trying to switch languages. 

To find out which languages are installed on a computer, open Control Panel. 
Click Region and Language. 

Installed languages are listed in the dialog box. The language that has a check 
mark beside it is the default language. 

For more information on adding alarm messages in multiple languages to a 
FactoryTalk Tag Alarm and Event Server, see Enter alarm messages in other 
languages on page 143. 

The following table lists the language identifiers: 

Language ID 
Afrikaans (South Africa) af-ZA 
Albanian (Albania) sq-AL 
Arabic (Algeria) ar-DZ 
Arabic (Bahrain) ar-BH 
Arabic (Egypt) ar-EG 
Arabic (Iraq) ar-IQ 
Arabic (Jordan) ar-JO 
Arabic (Kuwait) ar-KW 
Arabic (Lebanon) ar-LB 
Arabic (Libya) ar-LY 
Arabic (Morocco) ar-MA 
Arabic (Oman) ar-OM 
Arabic (Qatar) ar-QA 
Arabic (Saudi Arabia) ar-SA 
Arabic (Syria) ar-SY 
Arabic (Tunisia) ar-TN 
Arabic (U.A.E.) ar-AE 
Arabic (Yemen) ar-YE 
Armenian (Armenia) hy-AM 
Azeri (Cyrillic) az-Cyrl-AZ 
Azeri (Latin) az-Latn-AZ 
Basque eu-ES 
Belarusian be-BY 

Language identifiers 
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Language ID 
Bosnian (Cyrillic, Bosnia and Herzegovina) bs-Cyrl-BA 
Bosnian (Latin, Bosnia and Herzegovina) bs-Latn-BA 
Bulgarian bg-BG 
Catalan ca-ES 
Chinese (Hong Kong S.A.R.) zh-HK 
Chinese (Macau S.A.R.) zh-MO 
Chinese (PRC) zh-CN 
Chinese (Singapore) zh-SG 
Chinese (Taiwan) zh-TW 
Croatian (Croatia) hr-HR 
Czech (Czech Republic) cs-CZ 
Danish (Denmark) da-DK 
Divehi (Maldives) dv-MV 
Dutch (Belgium) nl-BE 
Dutch (Netherlands) nl-NL 
English (Australia) en-AU 
English (Belize) en-BZ 
English (Canada) en-CA 
English (Caribbean) en-029 
English (Ireland) en-IE 
English (Jamaica) en-JM 
English (New Zealand) en-NZ 
English (Philippines) en-PH 
English (South Africa) en-ZA 
English (Trinidad ) en-TT 
English (United Kingdom) en-GB 
English (United States) en-US 
English (Zimbabwe) en-ZW 
Estonian (Estonia) et-EE 
Faroese (Faroe Islands) fo-FO 
Farsi fa-IR 
Filipino(Philippines) fil-PH 
Finnish (Finland) fi-FI 
French (Belgium) fr-BE 
French (Canada) fr-CA 
French (France) fr-FR 
French (Luxembourg) fr-LU 
French (Monaco) fr-MC 
French (Switzerland) fr-CH 
Frisian (Netherlands) fy-NL 
FRYO (Macedonian) mk-MK 
Galician gl-ES 
Georgian ka-GE 
German (Austria) de-AT 
German (Germany) de-DE 
German (Liechtenstein) de-LI 
German (Luxembourg) de-LU 
German (Switzerland) de-CH 
Greek (Greece) el-GR 
Gujarati (India) gu-IN 
Hebrew (Israel) he-IL 
Hindi (India) hi-IN 
Hungarian (Hungary) hu-HU 
Icelandic (Iceland) is-IS 
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Language ID 
Indonesian (Indonesia) id-ID 
Inuktitut (Latin, Canada) iu-Latn-CA 
Irish (Ireland) ga-IE 
Italian (Italy) it-IT 
Italian (Switzerland) it-CH 
Japanese (Japan) ja-JP 
Kannada (India) kn-IN 
Kazakh (Kazakhstan) kk-KZ 
Konkani (India) kok-IN 
Korean (Korea) ko-KR 
Kyrgyz (Cyrillic) ky-KG 
Latvian (Latvia) lv-LV 
Lithuanian (Lithuania) lt-LT 
Luxembourgish (Luxembourg) lb-LU 
Malay (Brunei Darussalam) ms-BN 
Malay (Malaysia) ms-MY 
Maktese mt-MT 
Maori mi-NZ 
Mapudungun (Chile) arn-CL 
Marathi (India) mr-IN 
Mohawk (Mohawk) moh-CA 
Mongolian (Cyrillic) mn-MN 
Norwegian (Bokmal) nb-NO 
Norwegian (Nynorsk) nn-NO 
Polish (Poland) pl-PL 
Portuguese (Brazil) pt-BR 
Portuguese (Portugal) pt-PT 
Punjabi pa-IN 
Quechua (Bolivia) quz-BO 
Quechua (Equador) quz-EC 
Quechua (Peru) quz-PE 
Romanian (Romania) ro-RO 
Romansh (Switzerland) rm-CH 
Russian (Russia) ru-RU 
Sami, Inari (Finland) smn-FI 
Sami, Lule (Norway) smj-NO 
Sami, Lule (Sweden) smj-SE 
Sami, Northern (Finland) se-FI 
Sami, Northern (Norway) se-NO 
Sami, Northern (Sweden) se-SE 
Sami, Skolt (Finland) sms-FI 
Sami, Southern (Norway) sma-NO 
Sami, Southern (Sweden) sma-SE 
Sanskrit - India sa-IN 
Serbian (Cyrillic) sr-Cyrl-CS 
Serbian (Cyrillic, Bosnia and Herzdgovina) sr-Cryl-BA 
Serbian (Latin) sr-Latn-CS 
Serbian (Latin, Bosnia and Herzdgovina) sr-Latn-BA 
Sesotho sa Leboa (South Africa) ns-ZA 
Sestswana (South Africa) tn-ZA 
Slovak sk-SK 
Slovenian (Slovenia) sl-SI 
Spanish (Argentina) es-AR 
Spanish (Bolivia) es-BO 
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Language ID 
Spanish (Chile) es-CL 
Spanish (Colombia) es-CO 
Spanish (Costa Rica) es-CR 
Spanish (Dominican Republic) es-DO 
Spanish (Ecuador) es-EC 
Spanish (El Salvador) es-SV 
Spanish (Guatemala) es-GT 
Spanish (Honduras) es-HN 
Spanish (International Sort) es-ES 
Spanish (Mexico) es-MX 
Spanish (Nicaragua) es-NI 
Spanish (Panama) es-PA 
Spanish (Paraguay) es-PY 
Spanish (Peru) es-PE 
Spanish (Puerto Rico) es-PR 
Spanish (Traditional Sort) es-ES_tradnl 
Spanish (Uruguay) es-UY 
Spanish (Venezuela) es-VE 
Swahili (Kenya) sw-KE 
Swedish (Finland) sv-FI 
Swedish sv-SE 
Syriac (Syria) syr-SY 
Tamil (India) ta-IN 
Tatar (Russia) tt-RU 
Telugu (India) te-IN 
Thai (Thailand) th-TH 
Turkish (Turkey) tr-TR 
Ukrainian (Ukraine) uk-UA 
Urdu (Pakistan) ur-PK 
Uzbek (Cyrillic) uz-Cyrl-UZ 
Uzbek (Latin) uz-Latn-UZ 
Vietnamese (Vietnam) vi-VN 
Welch cy-GB 
Xhosa xh-ZA 
Zula zu-ZA 

For more information, see Enter alarm messages in other languages on page 
143.
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Appendix J 

Glossary 

In this section: 

A - C on page 195 

D on page 196 

E - P on page 197 

R - T on page 199 

- A -

Alarm history log 
A Microsoft SQL Server database that is configured to accept alarm and event 
data from the FactoryTalk Alarms and Events system. 

Analog alarm 
An analog alarm defines a condition that evaluates a single analog tag. The 
trigger condition compares the value of the tag against a defined static value 
using an operator: equal to, not equal to, greater than or equal to, less than or 
equal to, greater than, or less than. 

Application 
An application organizes project information, including elements such as 
data servers, HMI servers, and alarm and event servers, and makes the 
information available to all software products and computers participating in 
a FactoryTalk system. 

• Network distributed applications are held in a FactoryTalk Network
Directory. Project information and participating software products
can be located on multiple computers distributed across a network. All
of the computers participating in a particular network distributed
application share a common Network Directory Server located on a
network computer.

• Network station applications are held in a FactoryTalk Network
Directory. All participating software products (except for data servers)

A - C 
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must be installed on the same computer. Network station applications 
can connect to data servers that are located on different machines. All 
of the computers participating in a particular network station 
application share a common Network Directory Server located on a 
network computer. 

• Local station applications are held in a FactoryTalk Local Directory.
Project information is located on a stand-alone computer and is
available only to software products installed on that same local
computer. Local station applications cannot be accessed remotely and
cannot share project information with a network distributed
application or network station application.

Area 
Areas subdivide and organize a distributed network application into logical or 
physical divisions. For example, separate areas might correspond with 
separate manufacturing lines in a facility, separate plants in different 
geographical locations, or different manufacturing processes. 

Areas are not available with local station applications. 

- C -

Condition-related event 
An event associated with a change in the state of an alarm. For example, a 
condition-related event is triggered when an alarm condition changes to In 
Alarm, Acknowledged, Return to Normal, or Disabled. 

- D -

Data server 
Data servers serve tags, or data items, contained in OPC-DA (Data Access) 
servers. Clients that need access to data items, such as FactoryTalk View 
Studio and FactoryTalk Transaction Manager, use data server application 
elements referenced from the FactoryTalk Directory to locate the computers 
that are hosting OPC-DA 2.0 compliant data servers. 

D 
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Deviation alarm 
A deviation alarm defines a condition that evaluates a single analog tag. A 
trigger condition compares the value of a tag against a deviation from a target 
value. 

Device server 
A server process that connects to devices (controllers) and subscribes to alarm, 
status, and diagnostic information. A device server processes this data and 
publishes it to client processes for graphic display and logging. FactoryTalk 
Linx is one common example of a device server. See also data server. 

Device-based alarm monitoring 
With device-based alarm monitoring, pre-built alarm instructions, available 
in RSLogix 5000 v. 16 or later, are programmed in a logic project and then 
downloaded into a Logix 5000 controller. The controller detects alarm 
conditions and publishes event information, which is routed through the 
system for display and logging. 

Digital alarm 
A digital alarm defines a condition that evaluates a single digital tag. The 
trigger condition compares the value of the tag to either zero or one. 

Docked 
A graphic display that is fixed to the top, bottom, left or right side of a 
FactoryTalk View SE client window. 

Dongle 
A dongle is a security or copy protection device for commercial computer 
programs. When required by a program, a dongle must be connected to an 
input/output port, such as USB or parallel port of the computer, to allow the 
program to run. Programs that use a dongle query the port at start-up and at 
programmed intervals thereafter, and terminate if the dongle does not 
respond with the expected validation code. 

E - P 
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- E -

Enabled 
When an alarm is enabled, it is running its condition detection logic. Enabled 
alarms cannot be edited or deleted. 

- H -

HMI server 
HMI servers, also called FactoryTalk View SE Servers, store and serve HMI 
projects, which contain displays, alarms, tags and other services, to HMI 
clients such as FactoryTalk View Studio and FactoryTalk View SE Clients. HMI 
clients use FactoryTalk Directory to locate the computers that are hosting 
HMI servers. 

- L -

Level alarm 
A level alarm defines multiple conditions that evaluate a single level tag 
(sometimes called an analog tag). Each level can uniquely identify an alarm 
threshold, a severity, and an alarm message. 

- O -

Offline data item 
In RSLinx Classic, offline data points are read directly from a processor's 
project file defined in the RSLinx Classic DDE/OPC Topic Configuration (Use 
Symbols option). 

In FactoryTalk Linx, offline data points are read directly from a processor's 
project file defined in the device shortcut. For ControlLogix, offline tag 
browsing requires firmware version 10 or higher. 



Appendix J Glossary 
 

Rockwell Automation Publication FTAE-RM001M-EN-E - March 2021 199 

Online data item 
Online data items are read directly from a processor, exactly as they are 
defined in that processor. 

Using a Logix 5000 controller you can create tags right in the controller and 
use RSLinx Classic or FactoryTalk Linx to access those tags directly. As a 
result, you can work with symbol names in a Logix 5000 processor both online 
and offline. 

In a traditional PLC-5 or SLC 500 processor, tags are not created in the 
controller--instead symbol and tag names are associated with predefined PLC 
addresses. These associations are held in the logic program and are 
referenced by RSLinx Classic or FactoryTalk Linx. When reading data points 
online, only the PLC addresses exist inside the controller. You must work with 
RSLinx Classic offline data items to use ladder logic symbol names with these 
types of controllers. 

OPC 
OPC (OLE (Object Linking and Embedding) for Process Control) is a non-
proprietary technical specification that defines a set of standard interfaces 
based on Microsoft’s OLE/COM (Component Object Model) technology. 
Applying OPC standards makes interoperability possible among automation 
and control applications, field systems and devices, and business and office 
applications. 

The FactoryTalk Services Platform supports and extends the OPC 2.0 
specification, which includes the ability to browse data items. 

- P -

Policy 
A set of system-wide rules governing how security is implemented, such as 
rules related to password length and complexity. 

- R -

RSLinx 
RSLinx Classic and FactoryTalk Linx are families of software products that 
link networks and devices to products such as the FactoryTalk View family of 
HMI software and the RSLogix family of device-programming software. 

R - T 
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Two versions of RSLinx are commonly used in FactoryTalk systems: 

• RSLinx Classic: an OPC-DA 2.0 data server.
• FactoryTalk Linx: a FactoryTalk Live Data server and Alarms and

Events server.

RSLogix 
The RSLogix family of software products provides programming software for 
control devices, including the Logix 5000 series, PLC-5, and SLC 500. Use 
either of these two control programming tools to set up device-based alarm 
monitoring in FactoryTalk Alarms and Events: 

• Studio 5000 Logix Designer application, version 21.00.00 and later.
• RSLogix 5000 software, version 16.00.00 and later.

- S -

Simple event 
Any event describing a simple occurrence in the system. Example: failure to 
access a computer or device. 

- T -

Tag update rate 
The rate at which a tag is scanned for changes to its value. To reduce the 
quantity of network traffic, set the tag update rate to be as long as possible. 
For example, because an operator cannot respond to tag values that change 
faster than once every second, it is seldom necessary to set a tag update rate 
faster than once every few seconds. Set a faster tag update rate only if the 
system is programmed to respond automatically to tag values that change so 
quickly, bearing in mind the load this places on the network. 

Tag-based alarm monitoring 
Software-based Tag Alarm and Event Servers monitor controller tags for 
alarm conditions through data servers and publish event information for 
display and logging. Tag-based alarm monitoring is used for Logix 5000 
controllers, PLC-5, and SLC 500 devices communicating through Rockwell 
Automation Device Servers (FactoryTalk Linx), or for third-party controllers 
communicating through OPC data servers. 
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Tracking-related event 
An event that tracks changes made to the system over time. Examples: an 
event describing the acknowledgment of an alarm by an operator, or the 
modification of a tag value by an operator. 
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Legal Notices 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder on your 
hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf. 

Open Source Software Licenses 
The software included in this product contains copyrighted software that is 
licensed under one or more open source licenses.  

You can view a full list of all open source software used in this product and 
their corresponding licenses by opening the index.html file located your 
product's OPENSOURCE folder on your hard drive.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\Help\FactoryTalk 
Services Platform\Release Notes\OPENSOURCE\index.htm 

You may obtain Corresponding Source code for open source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: http://www.rockwellautomation.com/global/about-
us/contact/contact.page. Please include "Open Source" as part of the request 
text. 

Legal Notices 

https://www.rockwellautomation.com/global/legal-notices/overview.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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HMI Tag Alarm Monitoring  15 
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installation 

manual installation  159 
recommended hardware  9 
required software  9 

L 
Logix Designer 

Logix Designer projects  28 
version required  9 

Logix5000 Clock Update Tool 
starting automatically  176 
synchronizing clocks  177 
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enable an alarm  87, 88 
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tag-based alarm monitoring 
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Logix 5000 controllers  37 
OPC data servers  45 
third-party controllers  45 
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Windows 
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Rockwell Automation support 
Use these resources to access support information. 
Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification 

updates. 
rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and find 
associated firmware. 

rok.auto/pcdc 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 

http://rok.auto/support
http://rok.auto/knowledgebase
http://rok.auto/phonesupport
http://rok.auto/literature
http://rok.auto/pcdc
http://rok.auto/docfeedback
http://rok.auto/pec
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